IBM Planning Analytics
Version 2 Release 0

Getting Started with Planning Analytics on the Cloud
Note
Before you use this information and the product it supports, read the information in “Notices” on page 47.

Product Information
This document applies to IBM Planning Analytics Version 2.0 and might also apply to subsequent releases.
Licensed Materials - Property of IBM
Last updated: 2017-09-15

US Government Users Restricted Rights – Use, duplication or disclosure restricted by GSA ADP Schedule Contract with IBM Corp.
Contents

Introduction............................................................................................................................................. V

Chapter 1. Getting started with IBM Planning Analytics............................................................................. 1
  IBM Planning Analytics overview......................................................................................................................... 1
  IBM Planning Analytics non-production and production environments............................................................. 1
  IBM Planning Analytics standard system............................................................................................................. 2
  IBM Planning Analytics Digital Pack.................................................................................................................. 4
  IBM Planning Analytics applications and components.......................................................................................... 4
  IBM Planning Analytics shared folder.................................................................................................................. 5
  IBM Planning Analytics account and system information.................................................................................. 6
  The Welcome Kit............................................................................................................................................. 6
  Connecting to the IBM Planning Analytics remote desktop.............................................................................. 8
  Connecting with a Remote Desktop Gateway..................................................................................................... 9
  Connecting with a direct Remote Desktop Connection.................................................................................... 11
  IBM Planning Analytics and Windows Server 2012............................................................................................ 12
  Controlling access to services and shared folders............................................................................................ 13
  IBM Planning Analytics language configuration............................................................................................... 14
  Configuring and accessing documentation with IBM Planning Analytics.......................................................... 15

Chapter 2. Running IBM components with IBM Planning Analytics.......................................................... 17
  Planning Analytics Workspace............................................................................................................................... 17
  IBM Planning Analytics for Microsoft Excel.......................................................................................................... 17
  TM1 Web................................................................................................................................................................ 18
  TM1 Applications............................................................................................................................................... 19
  TM1 Operations Console...................................................................................................................................... 19
  TM1 Architect.................................................................................................................................................... 20
  TM1 Perspectives............................................................................................................................................... 20
  TM1 Performance Modeler................................................................................................................................. 21
  Cognos Command Center.................................................................................................................................. 21
  Setting up an agent in the Cognos Command Center server................................................................................ 22
  Setting up a computing resource in the Cognos Command Center server......................................................... 22
  Setting up a non-interactive account for use in the LDAP namespace............................................................ 23
  Setting up a computing resource for the non-interactive user......................................................................... 23
  Connecting on-premises or in the cloud................................................................................................................ 24
  Cognos Command Center documentation........................................................................................................ 27
  Running IBM Cognos Analytics with IBM Planning Analytics........................................................................... 27
  Adding your Cognos Analytics user account to the Planning Analytics server................................................ 27
  Creating a Planning Analytics data source as a Planning Analytics user............................................................ 28
  Assigning user permissions with TM1 security.................................................................................................. 28

Chapter 3. IBM Planning Analytics modeling tasks......................................................................................... 29
  Managing TM1 Servers using the Control command.......................................................................................... 29
  Running IBM Planning Analytics Control.......................................................................................................... 29
  Stopping and starting TM1 Servers..................................................................................................................... 29
  Updating content on the IBM Planning Analytics system................................................................................... 30
  Managing a secure gateway............................................................................................................................... 31
  Watch videos about IBM Secure Gateway......................................................................................................... 31
  Creating an IBM Secure Gateway....................................................................................................................... 31
  Add a data source to the Secure Gateway.......................................................................................................... 32
  Renewing a secure token.................................................................................................................................... 32
  Managing TM1 user accounts that use native security....................................................................................... 34
Introduction

This document describes how to interact with the IBM® Planning Analytics system and its TM1-related components. It also explains how to perform common tasks. This document helps you understand the steps and features that are unique to Planning Analytics in the cloud environment.

Because the Planning Analytics system operates in a remote hosted environment, this document explains how to remotely interact with and connect to the Planning Analytics system. The document also provides an overview of the Planning Analytics system and how to work with multiple cloud environments.

Information and steps are provided about the following tasks:

• How to run each of the programs that are provided with the Planning Analytics system.
• How to move files between your local computer and the Planning Analytics system.
• How to connect to the Planning Analytics system with a remote desktop session.

This document does not contain detailed information about each of the TM1® programs that are provided with the Planning Analytics system. Instead, a brief description of how each program works with the Planning Analytics system is provided along with links to the related documentation for these other programs.

Audience

To use this guide, you should be familiar with the following concepts:

• Your TM1 data and modeling requirements
• TM1 user security options and capabilities
• Basic Microsoft Windows file management
• Remote file management using File Transfer Protocol Secure (FTPS) tools
• Remote system access using remote desktop protocol (RDP) tools

Finding information

To find documentation on the web, including all translated documentation, access IBM Knowledge Center (http://www.ibm.com/support/knowledgecenter).

Accessibility features

Accessibility features help users who have a physical disability, such as restricted mobility or limited vision, to use information technology products. Some of the components in the Planning Analytics system have accessibility features. For information on these features, see the accessibility section in the documentation for each of the IBM components included in the Planning Analytics system.

IBM HTML documentation has accessibility features. PDF documents are supplemental and, as such, include no added accessibility features.

Samples disclaimer

The Sample Outdoors Company, Great Outdoors Company, GO Sales, any variation of the Sample Outdoors or Great Outdoors names, and Planning Sample depict fictitious business operations with sample data used to develop sample applications for IBM and IBM customers. These fictitious records include sample data for sales transactions, product distribution, finance, and human resources. Any resemblance to actual names, addresses, contact numbers, or transaction values is coincidental. Other sample files may contain fictional data manually or machine generated, factual data compiled from academic or public sources, or data used with permission of the copyright holder, for use as sample data to develop sample applications. Product names referenced may be the trademarks of their respective owners. Unauthorized duplication is prohibited.
Forward-looking statements

This documentation describes the current functionality of the product. References to items that are not currently available may be included. No implication of any future availability should be inferred. Any such references are not a commitment, promise, or legal obligation to deliver any material, code, or functionality. The development, release, and timing of features or functionality remain at the sole discretion of IBM.

Security considerations

For security considerations for IBM Planning Analytics, see Planning Analytics Installation and Configuration. Information on managing user and group authentication can be found in the Managing Users and Groups chapter of the TM1 Operations documentation.
Chapter 1. Getting started with IBM Planning Analytics

Modelers for IBM Planning Analytics should understand the overall cloud system and how it is different from a standard TM1 installation. They must understand how to connect to the IBM Planning Analytics system and provide this information to other users. They must also be familiar with the available components and ensure that users have the required connection information and operating instructions to run the available components.

IBM Planning Analytics overview

As a TM1 modeler, you should understand your IBM Planning Analytics environment and how the different components work together.

IBM Planning Analytics non-production and production environments

A typical IBM Planning Analytics solution includes two separate cloud environments or systems: one for non-production and one for production purposes. You receive a separate set of account information for each environment.

Note: Non-production environments are not available with Planning Analytics Digital Pack.

For example, you can use the non-production environment for development purposes and the production environment as your live environment. Each environment typically contains the following components:

- TM1 server
- hosted applications
- shared folder
- Planning Analytics Workspace tenant
- Cognos Analytics (Optional, not available with Planning Analytics Digital Pack.)

Note:
- Cognos Analytics in a production environment can be scaled as required to manage production-sized loads.
- Cognos Analytics in a non-production environment is not intended for production use or for performance testing. It is not designed to scale and does not have the same level of resources as the production Cognos Analytics environment.

Your organization may choose to subscribe to optional components, such as Cognos Analytics. It may also subscribe to additional non-production and production environments. For details about the specific environments that your organization is using, refer to your welcome kit.

As a TM1 modeler, you use a remote desktop connection from your local computer to connect to either cloud system. After you connect to a cloud system, you can run the applications that are hosted on that system.

You can move files between your local computer and the shared folder on either cloud system. You can also move files between the shared folders of different cloud systems.

The following figure shows the setup of Planning Analytics non-production and production environments.
IBM Planning Analytics standard system

The IBM Planning Analytics standard system provides a TM1 environment hosted on a secure, remote system that you and your users can access. Each IBM Planning Analytics system supports a collection of TM1 desktop, web-based, and mobile applications for end users and modelers. Each system also includes a shared folder for storing and accessing your data files.

The IBM Planning Analytics standard system includes the following main components:

- Planning Analytics Workspace
- Secure Gateway for data integration with on-premises ODBC data sources
- TM1 Server
- TM1 hosted and local applications
- IBM Planning Analytics system shared folder
- Cognos Analytics (optional, not available with Planning Analytics Digital Pack.)
- Watson Analytics for self-service analytics, to uncover new insights into opportunities and risks automatically from data. (Not available with Planning Analytics Digital Pack.)
The following figure provides an overview of the different components and applications that make up a typical IBM Planning Analytics system. The interaction between the TM1 server, hosted applications, local applications, and shared folder are shown.

![IBM Planning Analytics system overview](image)

**Figure 2: IBM Planning Analytics system overview**

**User access**

IBM Planning Analytics modelers have user accounts that let them connect directly to the IBM Planning Analytics system using a remote desktop protocol (RDP) connection or a File Transfer Protocol Secure (FTPS) application. This enables modelers to run the related TM1 desktop programs and to manage files in the shared folder on the IBM Planning Analytics system.

Typical non-modeler users connect to the IBM Planning Analytics system using only the web, mobile, and local Cognos® applications. Typical users do not connect to the IBM Planning Analytics system using RDP or FTPS.

Customers will get a user account for the remote desktop for every Planning Analytics Modeler Authorized User that they subscribe to and there is no licensing or technical restriction on the number of concurrent users.

**TM1 Admin Server and TM1 Server**

Your IBM Planning Analytics system uses the following default names for the TM1 Admin Host and TM1 Server:

- Default TM1 Admin Host name: data
- Default TM1 Server name: tm1

**Shared data between TM1 servers**

IBM Planning Analytics allows, by default, any of your TM1 servers to access any data files that are in your shared folder.
Note: In previous versions of IBM Planning Analytics, a TM1 server could access only its own data directory and subfolders. The data directory folder is located at the same level as the file `tm1s.cfg`. If you want to keep the previous restrictions in place to ensure that one TM1 Application cannot access the files of another TM1 application, send a PMR to the Cloud Operations team.

Secure access to on-premises data

IBM Planning Analytics can access on-premises ODBC data sources securely using the IBM Secure Gateway service. With an ODBC driver installed on the cloud and the Secure Gateway client installed on the customer site, on-premises data can be leveraged by Planning Analytics applications. For example, TurboIntegrator can efficiently process data related to scheduling; drill-through operations; and Extract, Transform, and Load (ETL) operations.

IBM Planning Analytics Digital Pack

IBM Planning Analytics Digital Pack provides a scaled down version of the Planning Analytics standard system. It is intended for a small business or department of between 5 and 20 users.

Planning Analytics Digital Pack contains all of the core Planning Analytics components. However, it does not contain these additional components that are found in the Planning Analytics standard system:

- IBM Cognos Analytics
- IBM Watson Analytics
- IBM Cognos Command Center
- IBM Cognos Integration Server
- Planning Analytic non-production environments

Up to three Planning Analytics Digital Pack users can be provided with Remote Desktop Protocol (RDP) connections. RDP connections allow users to connect to hosted applications.

If you would like to upgrade from the Planning Analytics Digital Pack to the Planning Analytics standard system, please contact your account manager.

IBM Planning Analytics applications and components

IBM Planning Analytics includes a collection of components for monitoring, modeling, analyzing, and interacting with TM1 data. These components are either hosted on the IBM Planning Analytics system or installed directly on your local computer or mobile device. All of the components connect to the TM1 Server that runs on the IBM Planning Analytics system.

For information on running each of these components, see Chapter 2, “Running IBM components with IBM Planning Analytics,” on page 17.

Hosted applications

The IBM Planning Analytics system computer hosts Planning Analytics programs that are accessed either from a web browser or by remote desktop connection.

The following web-based applications run on the IBM Planning Analytics system. You access these applications using a web browser on your local computer.

- Planning Analytics Workspace
- Planning Analytics Control
- TM1 Web
- TM1 Applications
- TM1 Operations Console
- Watson Analytics *
- Cognos Analytics Report Studio *
- Cognos Analytics Workspace *
- Cognos Analytics Workspace Advanced *
- Cognos Analytics Connections *

* Not available with Planning Analytics Digital Pack
The following desktop applications run on the IBM Planning Analytics system. You access these applications with a remote desktop connection to the IBM Planning Analytics system that uses the remote desktop protocol (RDP).

- TM1 Perspectives
- TM1 Architect
- TM1 Performance Modeler

**Local applications**
The following IBM Cognos programs are installed and run directly on your local computer and remotely access the IBM Planning Analytics system:

- IBM Planning Analytics for Microsoft Excel
- IBM Cognos Integration Server *
- IBM Cognos Command Center *

* Not available with Planning Analytics Digital Pack

**Mobile applications**
Planning Analytics users can run Cognos BI Mobile and connect to their BI capabilities that are a part of Planning Analytics.

**Note:** Cognos BI Mobile is not available with Planning Analytics Digital Pack.

**IBM Planning Analytics shared folder**
The IBM Planning Analytics system provides a dedicated shared folder for your TM1 data and related files.

The shared folder is accessible only with the shared folder user name, password, and addresses that were provided in the Cloud Welcome Kit.

**Shared folder content**
The shared folder contains the following files:

- TM1 data and log files
- Transfer archive files from TM1 Performance Modeler
- Transfer specification files from TM1 Performance Modeler
- Installation files for IBM Planning Analytics for Microsoft Excel
- Installation files for IBM Cognos Integration Server (not available with Planning Analytics Digital Pack)
- Installation files for IBM Cognos Command Center (not available with Planning Analytics Digital Pack)
- Other files and documents that you want to use with your IBM Planning Analytics system

**Accessing the shared folder**
You can use your shared folder account user name and password to access the shared folder in the following ways:

- Use the Windows File Explorer in the remote desktop session to manage files in the shared folder.
- Use a File Transfer Protocol Secure (FTPS) application on your local computer to move files between your local computer and the shared folder.

**Important:** To ensure that your data is encrypted when transferred, the IBM Planning Analytics system FTP connection is configured to use FTP with Secure Sockets Layer (FTPS). Make sure to use an FTP application that supports FTPS.

- If you have multiple cloud environments, you can use File Explorer to move files between the shared folders in each environment.

For detailed steps about accessing your shared folder, see “Managing files in the IBM Planning Analytics shared folder” on page 34.

**Data backup for the shared folder**
The files in the shared folder are backed up on regular basis. Check with IBM Support for more information.
Important: Only the shared drive is backed up. Therefore, you risk losing your data if you store files on the remote desktop disk drive.

IBM Planning Analytics account and system information

The IBM Planning Analytics system is managed and accessed through a group of dedicated user accounts and system addresses that are assigned to your company or organization.

When you first use your IBM Planning Analytics system, you are provided with an IBM Planning Analytics Welcome Kit file for each IBM Planning Analytics system you requested.

The Welcome Kit

The IBM Planning Analytics Welcome Kit file contains a set of account and system information that is unique for your IBM Planning Analytics system. The information includes the main user account credentials, system addresses, and URLs that you use to connect to one specific IBM Planning Analytics system. 

Note: The information in the IBM Planning Analytics Welcome Kit supersedes the online documentation if differences or questions arise.

The file for the IBM Planning Analytics Welcome Kit uses the following naming format:

customername - IBM Planning Analytics Welcome Kit date.txt

Important: Keep this information in a safe place. The provided user accounts are only for modelers who need remote desktop and file transfer access to the IBM Planning Analytics system.

This video shows you how to use the Welcome Kit:

https://youtu.be/CwNdY6jYbSI

A typical IBM Planning Analytics system includes the following account and system information:

IBM Planning Analytics system address

The unique system address for your IBM Planning Analytics system. Use this information for remote desktop access to your IBM Planning Analytics system.

Typical format:

customername.planning-analytics.ibmcloud.com

You typically have more than one IBM Planning Analytics system address. For example, you might have addresses for non-production and production cloud environments.

User account names and passwords

Each IBM Planning Analytics system includes multiple user accounts.

Remote desktop user account

User name and password for your remote desktop user account.

Use this account when you run a remote desktop session on the IBM Planning Analytics system. For example, you use a remote desktop session to run the hosted desktop-based programs such as TM1 Performance Modeler and TM1 Architect.

The user names for this account use the format modeler1, modeler2 to modelerX. Depending on your exact IBM Planning Analytics system, you might have one or more of these user accounts.

Important: This user account is only for TM1 modelers, and not for standard users of TM1.

IBM ID account

User name and password for the primary TM1 administrator account.

Use this account to log in to TM1 Performance Modeler or TM1 Architect to create other TM1 user accounts. For more information, see “Managing TM1 user accounts that use native security” on page 34.

You can also use this account to log in to any of the TM1 user interfaces.
Cognos Command Center agent account
User name and password for the Cognos Command Center agent.
Use this account to log in to Cognos Command Center to work with agents. For more information, see “Setting up an agent in the Cognos Command Center server” on page 22.

**Note:** Cognos Command Center is not available with Planning Analytics Digital Pack.
The IBM Planning Analytics Welcome Kit contains other information that you can use to work with Cognos Command Center.

Non-interactive TM1 account
User account information for use in the LDAP namespace, which you can use when you have automation tools and processes that are scheduled or require the user name and password to be non-interactive.
Using the following account, a customer can automate processes that involve their Planning Analytics Cloud TM1 server.
- User name: `<customer>_tm1_automation`
- Password: `<generated>`
- CAM Namespace: LDAP

On the Cognos Command Center on-premises server:
1. Create a Planning Analytics Cloud Agent by using the Cognos Command Center Agent user (admin) from the welcome kit.
2. Create a Planning Analytics Cloud TM1 computing resource by using the new `<customer>_tm1_automation` from the welcome kit.

For more information, see “Setting up a non-interactive account for use in the LDAP namespace” on page 23.

Shared folder account
User name and password for File Transfer Protocol Secure (FTPS) and Windows file sharing with the shared folder on your IBM Planning Analytics system.

TM1 Server control account
User name and password for the Control command, which you can use to start and stop any TM1 service in your IBM Planning Analytics system.

Planning Analytics modeling applications
Use this information for remote desktop access to TM1 Performance Modeler, TM1 Architect, and TM1 Perspectives.

For example, use a Microsoft Windows Remote Desktop Connection with the following format to remotely connect to your IBM Planning Analytics system:
https://<customernamem>.planning-analytics.ibmcloud.com

**Note:** If you are prompted when you start TM1 Performance Modeler, make sure the IBM Cognos TM1 system URL field contains the following URL: https://<customernamem>.planning-analytics.ibmcloud.com/pmpsvc/services

URLs for Planning Analytics web-browser-based applications
You can provide these URLs to your users so they can access the related Planning Analytics web-based applications from their web browsers.
- IBM Planning Analytics Workspace
  https://www.planning-analytics.ibmcloud.com

  **Tip:** Your desktop system address is listed in your Welcome Kit. When Remote Desktop Gateway is enabled, the address for your IBM Planning Analytics system is server_name.rich.planning-analytics.ibmcloud.com. The suffix rich must be appended to the server_name.
- TM1 Web
  https://<customernamem>.planning-analytics.ibmcloud.com/tm1web/
- TM1 Applications
https://customernamex.planning-analytics.ibmcloud.com/pmpsvc/
• TM1 Operations Console
  https://customernamex.planning-analytics.ibmcloud.com/pmhub/pm/opsconsole/

**URLs for Planning Analytics web-connected applications**
Use this information to configure a remote data connection for the following application.
• IBM Planning Analytics for Microsoft Excel
  https://customernamex.planning-analytics.ibmcloud.com

**Shared folder information**
User account information for File Transfer Protocol Secure (FTPS) and Windows file sharing with the shared folder on your IBM Planning Analytics system. This information includes user name, password, and addresses assigned to your shared folder.

For detailed steps about accessing your shared folder, see “Managing files in the IBM Planning Analytics shared folder” on page 34.

---

**Connecting to the IBM Planning Analytics remote desktop**

Connect to the IBM Planning Analytics remote desktop so that you can run the hosted desktop-based applications or manage files in the shared folder. For example, you can connect using Microsoft Remote Desktop Connection and then run TM1 Architect, TM1 Perspectives, and TM1 Performance Modeler.

**Before you begin**
IBM Planning Analytics is configured to support only secure Remote Desktop Protocol (RDP) connections.

To successfully connect to an IBM Planning Analytics desktop session, you must use an RDP application that supports Network Level Authentication (NLA). RDP applications are available for both Microsoft Windows and non-Windows platforms.

For example, you can use the built-in Remote Desktop Connection feature in Microsoft Windows 7, Vista, and XP. For more information about this feature, search the Microsoft website for "Connect to another computer using Remote Desktop Connection".

Depending on how your Planning Analytics environment is configured, you connect to the remote desktop either via a Remote Desktop Gateway or directly, using Remote Desktop Connection.

Before you connect, perform these tasks:

**Verify that your version of Windows Remote Desktop Connection supports Network Level Authentication**

1. Start Remote Desktop Connection.
   **Tip:** This tool is typically located here: Start menu > All Programs > Accessories > Remote Desktop Connection.
2. In the Remote Desktop Connection window, click the program icon in the upper left corner of the window and then click About.
3. Verify that the following text is listed: Network Level Authentication supported.

**Configure your RDP application to run Windows key combinations on the remote computer**

1. In Remote Desktop Connection, click Show Options > Local Resources tab.
2. Under the Keyboard section, set the Apply Windows key combinations option to On the remote computer.

   This option sends your keyboard shortcuts for the Windows logo key and other key combinations to the remote computer and runs them there.

**About this task**

This video shows you how to access the Planning Analytics remote desktop:

https://youtu.be/irJxnZfDjYs
What to do next

Using your RDP application, you can now access the IBM Planning Analytics remote desktop as follows:

• Using a Remote Desktop Gateway
• Using a direct Remote Desktop Connection

Tip: To find out which method your team uses to connect to the remote desktop, ask your Planning Analytics administrator. Alternatively, you can open the Welcome Kit and search for the following sentence:

The remote desktop connection is provided over HTTPS (port 443)

• If the sentence above appears in the Welcome Kit, your team connects through a Remote Desktop Gateway.
• If the sentence above does not appear in the Welcome Kit, your team connects using a direct Remote Desktop Connection.

Connecting with a Remote Desktop Gateway

A Remote Desktop Gateway allows authorized users to connect to the Planning Analytics remote desktop using both Remote Desktop Protocol (RDP) and HTTPS protocol.

HTTPS protocol provides encryption between your computer and the remote desktop. It uses port 443, which transmits data through a Secure Sockets Layer (SSL) tunnel. This means that port 3389, the port used for Remote Desktop connections, is blocked to enhance network security.

Tip: Perform this task only if your Planning Analytics system is configured for a Remote Desktop Gateway. To find out which method your team uses to connect to the remote desktop, ask your Planning Analytics administrator. Alternatively, you can open the Welcome Kit and search for the following sentence:

The remote desktop connection is provided over HTTPS (port 443)

• If the sentence above appears in the Welcome Kit, your team connects through a Remote Desktop Gateway.
• If the sentence above does not appear in the Welcome Kit, your team connects using a direct Remote Desktop Connection.

Default connection features of the Remote Desktop Gateway

When your team connects through a Remote Desktop Gateway, some Remote Desktop connection features are enabled by default. You can enable or disable certain connection features by sending a request to IBM Support. The following table lists features of the Remote Desktop Gateway, their default availability, and whether you can enable or disable the feature by contacting IBM Support.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Default feature availability</th>
<th>Can the feature availability be changed?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clipboard (allows you to copy or paste files and text).</td>
<td>Enabled</td>
<td>Yes</td>
</tr>
<tr>
<td>Access to local drives.</td>
<td>Enabled</td>
<td>Yes</td>
</tr>
<tr>
<td>Printing to a local printer.</td>
<td>Disabled</td>
<td>Yes</td>
</tr>
<tr>
<td>Timeout after an idle session.</td>
<td>30 minutes</td>
<td>Yes</td>
</tr>
<tr>
<td>Redirection using COM and LPT ports.</td>
<td>Disabled</td>
<td>No</td>
</tr>
<tr>
<td>Redirection using Plug and Play devices.</td>
<td>Disabled</td>
<td>No</td>
</tr>
</tbody>
</table>

Note: The same connection features are available to all users of the Remote Desktop Gateway, regardless of their user roles.

Procedure

1. Start Remote Desktop Connection.
2. Click Show Options.
3. In the Connection settings section, click Open.
4. Select the RDP file for your platform that was provided in your Welcome Kit zip file and click Open.

   Tip: The Welcome Kit zip file contains preconfigured RDP files for Windows, Macintosh, and Linux. These RDP files are also available on the Planning Analytics remote desktop shared folder in \data\s\install\Remote Desktop Services.

5. Click Connect.

   Tip: If a message appears saying that the publisher of the remote connection can't be identified, click Connect.

6. Enter your remote desktop system password.

   Tip: Your password is listed in the Welcome kit. If you don't know the password, ask your Planning Analytics administrator.

If the connection is successful, the desktop of the IBM Planning Analytics system is displayed.

   Tip: If the newer Windows Start menu desktop displays instead of the classic desktop view, click the Desktop icon or press the Windows logo key to toggle to the classic desktop view.

What to do next

After you connect to an IBM Planning Analytics desktop session, you can run the hosted desktop applications and manage files in the shared folder.

Manually connecting with a Remote Desktop Gateway (optional)

You can manually connect to a Remote Desktop Gateway if you want to customize some settings in your remote desktop connection.

Note: Unless your Planning Analytics administrator advises otherwise, we recommend that you connect using the preconfigured RDP files in the Welcome Kit zip file.

Before you connect manually with a Remote Desktop Gateway, you must configure your Remote Desktop Connection client.

Configuring your Remote Desktop Connection client

Configure your Remote Desktop Connection client to use a Remote Desktop Gateway.

Procedure

1. Start Remote Desktop Connection.

   Tip: This tool is typically located here: Start menu > All Programs > Accessories > Remote Desktop Connection.

2. Enter your IBM Planning Analytics account information:

   a. In the Computer field, enter the address for your IBM Planning Analytics system.
      
      For example:
      
      server_name.planning-analytics.ibmcloud.com
      
      Tip: Your desktop system address is listed in your Welcome Kit. When Remote Desktop Gateway is enabled, the address for your IBM Planning Analytics system is server_name\rich.planning-analytics.ibmcloud.com. The suffix rich must be appended to the server_name.
      
   b. Click Show Options.
   c. Enter your user name for your Windows remote desktop account on the IBM Planning Analytics system. For example, server_name\modelerX.

3. Select the Allow me to save credentials check box.

4. Click the Advanced tab and then click Settings.

5. In the RD Gateway Server Settings dialog, do the following:

   a. Select Use these RD Gateway server settings.
   b. Ensure that your IBM Planning Analytics address, for example server_name\rich.planning-analytics.ibmcloud.com, appears in the Server name field.
   c. Ensure that the Bypass RD Gateway server for local addresses check box is not selected.
   d. Select Use my RD Gateway credentials for the remote computer.
6. Save your connection settings to an RDP file.

   **Note:** By creating an RDP file, you can quickly connect in your next Remote Desktop Connection session, without re-entering your credentials. You can also customize and distribute the RDP file later to multiple clients.
   
   a. Click the **General** tab.
   b. Click **Save As** and enter a name for your RDP file.
   c. Click **Save**.

### Connecting manually with the Remote Desktop Gateway

**Procedure**

1. Start Remote Desktop Connection.
2. If you want to connect using an RDP file that you saved, follow these steps:
   
   a. Click **Show Options**.
   b. In the **Connection settings** section, click **Open**.
   c. Select the RDP file that you saved and click **Open**.
3. If you want to enter the connection information manually, follow these steps:
   
   a. In the **Computer** field, enter the address for your IBM Planning Analytics system.
      
      For example: `server_name.planning-analytics.ibmcloud.com`
      
      **Tip:** Your desktop system address is listed in your Welcome Kit. When Remote Desktop Gateway is enabled, the address for your IBM Planning Analytics system is `server_name\rich.planning-analytics.ibmcloud.com`. The suffix `rich` must be appended to the `server_name`.
   b. Click **Show Options**.
   c. Enter your user name for your Windows remote desktop account on the IBM Planning Analytics system. For example, `server_name\modeler\X`.
4. Click **Connect**.
   
   **Tip:** If a message appears saying that the publisher of the remote connection can't be identified, click **Connect**.
5. Enter your remote desktop system password.

   **Tip:**
   - Your password is listed in the Welcome kit. If you don't know the password, ask your Planning Analytics administrator.
   - The credentials that you use for Remote Desktop Gateway and Remote Desktop Connection must be the same.

   If the connection is successful, the desktop of the IBM Planning Analytics system is displayed.

   **Tip:** If the newer Windows Start menu desktop displays instead of the classic desktop view, click the **Desktop** icon or press the Windows logo key to toggle to the classic desktop view.

### What to do next

After you connect to an IBM Planning Analytics desktop session, you can run the hosted desktop applications and manage files in the shared folder.

### Connecting with a direct Remote Desktop Connection

Use a direct remote desktop connection to connect to the Planning Analytics desktop through port 3389. Remote Desktop Protocol (RDP) uses port 3389 for Remote Desktop connections.

**Tip:** Perform this task only if your Planning Analytics system is configured for a direct Remote Desktop Connection. To find out which method your team uses to connect to the remote desktop, ask your Planning Analytics administrator. Alternatively, you can open the Welcome Kit and search for the following sentence:

The remote desktop connection is provided over HTTPS (port 443)
• If the sentence above appears in the Welcome Kit, your team connects through a Remote Desktop Gateway.
• If the sentence above does not appear in the Welcome Kit, your team connects using a direct Remote Desktop Connection.

Procedure
1. Start Remote Desktop Connection.
   Tip: This tool is typically located here: Start menu > All Programs > Accessories > Remote Desktop Connection.
2. Enter your IBM Planning Analytics account information:
   a. In the Computer field, enter the address for your IBM Planning Analytics system.
      For example: 
      `server_name.planning-analytics.ibmcloud.com`
      Tip: Your desktop system address is listed in your Welcome Kit.
   b. Click Show Options.
   c. Enter your user name for your Windows remote desktop account on the IBM Planning Analytics system. For example, `server_name\modelerX`.
3. Click Connect.
   Tip: If a message appears saying that the publisher of the remote connection can't be identified, click Connect.
4. Enter your remote desktop system password.
   Tip: Your password is listed in the Welcome kit. If you don't know the password, ask your Planning Analytics administrator.

What to do next
After you connect to an IBM Planning Analytics desktop session, you can run the hosted desktop applications and manage files in the shared folder.

IBM Planning Analytics and Windows Server 2012

The IBM Planning Analytics system runs on the Microsoft Windows Server 2012 R2 operating system. You interact with the Windows Server 2012 user interface when you connect to the IBM Planning Analytics system with a remote desktop connection.

As a modeler for IBM Planning Analytics, you should understand the Windows Server 2012 R2 user interface and some basic keyboard shortcuts. Knowing these features will help you when you work in the remote desktop session on the IBM Planning Analytics system.

Windows Updates
IBM Support manages and applies updates to the Windows operating system of your cloud environment.

Attention: When you use the remote desktop session on your IBM Planning Analytics system, do not try to run the Windows Update feature even if prompted.

Windows Server 2012 user interface
Microsoft Windows Server 2012 R2 has a user interface that is similar to the UI in Microsoft Windows 8. The IBM Planning Analytics system can display either the new UI or the classic Windows desktop view. When you connect to the system with a remote desktop connection, you can switch between these desktop views.

The shortcuts to open the hosted TM1 desktop applications are available only in the classic Windows desktop view. Use the Windows logo key to switch between the classic desktop view and the new desktop view.
You can find out more about Windows Server 2012 R2 by searching the internet for the following phrases:

- "common management tasks and navigation in Windows Server 2012"
- "ebook introducing Windows Server 2012 microsoft press RTM Edition"
- "keyboard shortcuts Windows Server 2012"

**Windows Server 2012 basic keyboard shortcuts**

You can use the following basic keyboard shortcuts for Windows Server 2012 R2.

**Tip:** To make sure that your keyboard shortcuts are run on the IBM Planning Analytics system computer, configure your remote desktop connection to apply Windows key combinations on the remote computer. For more information, see “Connecting to the IBM Planning Analytics remote desktop” on page 8.

**Windows logo key**

Toggles between the classic Windows desktop view and the new Windows desktop view.

**Remember:** The shortcuts to open the hosted TM1 desktop applications are available only in the classic Windows desktop view.

**Windows logo key + d**

Minimizes all running programs and displays only the classic Windows desktop. Press these keys a second time to toggle back to your running programs.

**Windows logo key + q**

Displays the general search tool.

**Windows logo key + f**

Displays the file search tool.

### Controlling access to services and shared folders

You can request that only specific computers have access to your web services. You can also control which people have access to shared folders and what their permissions are.

#### Controlling computer access to web services

You can request that only specific computers have access to the web services that are not shared with other customers. You use a whitelist document to list the IP ranges of computers that will have access.

**Note:** You cannot create a whitelist to control access to the web services of Planning Analytics Workspace, Watson Analytics, and Cognos Analytics. This is because they are all shared services.

To ensure a high level of IBM support, the Monitoring tools and Operations team for IBM Planning Analytics will still have access to your web services, even if you do not include their IP addresses in a whitelist file.

1. Open a service request and assign it to IBM Support.
2. Create a text file and give it the name `incoming_firewall_whitelist.txt`.
3. In the text file, list the ranges of IP addresses that you want to have access to the web services.

   **Tip:** Computers whose IP addresses are listed will have access to all web services, for example, FTP, RDP, and HTTP.

4. Attach the file `incoming_firewall_whitelist.txt` to the service request.
5. Submit the service request.

#### Controlling user access to shared folders

You can request that certain user permissions be applied to specific subfolders in your shared folder.

For more information, see “IBM Planning Analytics shared folder” on page 5.

**Note:** Your IBM Planning Analytics environment will go offline while your requested changes are applied.

1. Open a service request and assign it to IBM Support.
2. Create a text file and give it the name `shared_folder_acls.txt`.
3. Create a table with up to five columns, separated by tabs. Each row represents a separate Access Control List (ACL).
Here is an example:

<table>
<thead>
<tr>
<th>Path</th>
<th>User</th>
<th>Permissions</th>
<th>Inherit</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>/</td>
<td>fs_rp2team4_admin</td>
<td>rwd</td>
<td>true</td>
<td>allow</td>
</tr>
<tr>
<td>/prod/data/</td>
<td>fs_rp2team4_servers</td>
<td>r</td>
<td>true</td>
<td>allow</td>
</tr>
</tbody>
</table>

The column entries in the table represent the following information:

- The first column entry is the path and uses forward slashes (/). A single forward slash (/) indicates the root of the shared folder.
- The second column entry is the user name. It must start with "fs_", followed by the environment name, followed by a final part that you can define. The entry is limited to 20 characters.

**Tip:** You should create a user with full permissions, such as "fs_rp2team4_admin" in the example.

- The third column entry is the permissions - r (read), w (write) and delete (d). If no permission is specified, then rwd is assumed.
- The fourth column entry indicates whether the ACL should be inherited (that is, child objects will inherit this ACL). The default is true. The options are "true" and "false".
- The fifth column entry indicates if this is an "allow" or "deny" permission. The default is "allow".

4. Attach the file shared_folder_acls.txt to the service request.
5. Submit the service request.

**Controlling TM1 server access to data in shared folders**

IBM Planning Analytics allows, by default, any of your TM1 servers to access any data files that are in your shared folder.

**Note:** In previous versions of IBM Planning Analytics, a TM1 server could access only its own data directory and sub-folders. The data directory folder is located at the same level as the file tm1s.cfg.

If you want to keep the previous restrictions in place to ensure that one TM1 Application cannot access the files of another TM1 application, send a PMR to the Cloud Operations team.

**IBM Planning Analytics language configuration**

You can configure the user interface language for the TM1 programs that are provided with IBM Planning Analytics. These programs can be configured to use the same languages as the standard version of TM1.

Make sure that the language that you select is one of the supported languages for TM1 listed in the topic TM1 language codes (http://www.ibm.com/support/knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.tm1_inst.2.0.0.0.doc/c_tm1_inst_tm1languagecodes.html).

**Language for cloud-hosted desktop programs**

You configure the user interface language for the desktop programs that are hosted in the cloud remote desktop session by using the Microsoft Windows Control Panel > Language > Add a language option.

This configuration applies to the following programs:

- TM1 Perspectives
- TM1 Architect
- TM1 Performance Modeler

**Language for cloud-hosted web browser-based programs**

You configure the user interface language for web-based programs by changing the language option in your web browser.

This configuration applies to the following programs:

- TM1 Web
- TM1 Applications
• TM1 Operations Console

**Language for local programs**
To change the user interface language for the programs that you run on your local computer, use the Windows Language options.

This configuration applies to the following programs:
• Planning Analytics for Microsoft Excel

### Configuring and accessing documentation with IBM Planning Analytics

You can access TM1 documentation on IBM Knowledge Center using a web browser, or directly from the Help menu in any of the TM1 components. If you would like to access TM1 documentation from within the cloud remote desktop session, you must configure the remote web browser to include the documentation locations as trusted sites.

To correctly display TM1 documentation within the remote desktop session of the IBM Planning Analytics system, configure the Microsoft Internet Explorer web browser on the IBM Planning Analytics system.

1. On the IBM Planning Analytics system, open Microsoft Internet Explorer.
2. Click **Tools > Internet Options** and then click the **Security** tab.
3. Add the location for the TM1 Performance Modeler Help system.
   a. Click **Local intranet** and then click the **Sites** button.
   b. Click **Add** and enter `http://127.0.0.1`
   c. Click **Close**.
4. Add the base URL for IBM Knowledge Center:
   a. Click **Trusted sites** and then click the **Sites** button.
   b. Click **Add** and enter `http://www.ibm.com`
   c. Click **Close**.
5. Click **OK** to close the Internet Options dialog box.

**Accessing TM1 documentation on IBM Knowledge Center**
You can use IBM Knowledge Center to access all of the available TM1 documentation.

Chapter 2. Running IBM components with IBM Planning Analytics

As a modeler, you should understand how to run the IBM components that are available with IBM Planning Analytics.

Planning Analytics Workspace

IBM Planning Analytics Workspace is a web-based interface for TM1.

To run Planning Analytics Workspace, follow these steps:

1. On your local computer, open a web browser and enter the following URL:
   https://www.planning-analytics.ibmcloud.com
2. Enter the required information on the login page.
   - For **username** and **password**, enter your IBM ID and password.
   - **Tip:** To register for your IBM ID, go to the IBM ID registration page (https://ibm.biz/BdHtLT).
3. Click Login.

Planning Analytics Workspace documentation

You can access help for Planning Analytics Workspace from within the Planning Analytics Workspace application.

To see the online help inside Planning Analytics Workspace, tap Docs, and then Docs.

To navigate back to Planning Analytics Workspace, tap Docs:

Then tap either Welcome or the name of the book.

IBM Planning Analytics for Microsoft Excel

You can use IBM Planning Analytics for Microsoft Excel to access data from the TM1 server on your IBM Planning Analytics system.

To use Planning Analytics for Microsoft Excel with IBM Planning Analytics, you first need to download, install, and configure the application. Depending on who needs to use the application, you might need to distribute or make available the installation program to other TM1 users in your organization.
Downloading and installing Planning Analytics for Microsoft Excel

Installation files for Planning Analytics for Microsoft Excel are located in your shared folder on your IBM Planning Analytics system.

1. Connect to your shared folder on your IBM Planning Analytics system using an FTP application that supports File Transfer Protocol Secure (FTPS).
   
   For more information, see “Copying local files to IBM Planning Analytics” on page 35.
2. Locate the 32-bit or 64-bit installation programs in the following location and download them to your local computer.

   - `\data\install\Planning Analytics for Microsoft Excel`

3. Run the installation program on your local computer by double-clicking the `issetup.exe` file.
4. Distribute or make available the installation program to other TM1 users in your organization.

For more information about installing Planning Analytics for Microsoft Excel, see “Planning Analytics for Microsoft Excel installation and configuration” on IBM Knowledge Center (https://www.ibm.com/support/knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.tm1_inst.2.0.0.doc/c_ig_cor_overview.html)

Connecting Planning Analytics for Microsoft Excel to IBM Planning Analytics

You must configure your installation of Planning Analytics for Microsoft Excel before it can access the TM1 server on your IBM Planning Analytics system.

1. Use the **Options** icon in the toolbar of Planning Analytics for Microsoft Excel to configure a connection to the IBM Planning Analytics system.
2. Add the address for Planning Analytics for Microsoft Excel that is provided in the IBM Planning Analytics Welcome Kit. For example:

   ```
   https://customernam_e.planning-analytics.ibmcloud.com/
   ```

   For more information, see Setting up connections to IBM Cognos systems (https://www.ibm.com/support/knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/t_ug_cxr_mddmdfrl.html#id_cxr_gt_strtd_modify_URL) in Planning Analytics for Microsoft Excel.

Planning Analytics for Microsoft Excel documentation

The following documentation for Planning Analytics for Microsoft Excel is available on IBM Knowledge Center:

- Planning Analytics for Microsoft Excel installation and configuration (https://www.ibm.com/support/knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.tm1_inst.2.0.0.doc/c_ig_cor_overview.html)
- Planning Analytics for Microsoft Excel (https://www.ibm.com/support/knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/c_corwelcomeintro.html)

TM1 Web

TM1 Web is hosted on the IBM Planning Analytics system and runs in a web browser on your local computer.

To run TM1 Web, you must know the related URL from the IBM Planning Analytics Welcome Kit and have a valid TM1 user account.

1. On your local computer, open a web browser and enter the URL that was provided for TM1 Web.
   
   For example, TM1 Web uses the following URL format:

   ```
   https://customernam_e.planning-analytics.ibmcloud.com/tm1web/
   ```

2. Enter the required information on the login page.

   - For **TM1 Server**, use the default value of **tm1**.
   - For **User Name** and **Password**, enter your registered IBM ONE ID and password.
3. Click **Login**.
**TM1 Web documentation**
The following documentation for TM1 Web is available on IBM Knowledge Center:

TM1 Perspectives, TM1 Architect, and TM1 Web ([https://www.ibm.com/support/knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.tm1_ug.2.0.0.doc/c_tm1_ug_pref_intro.html#tm1_ug_pref_intro](https://www.ibm.com/support/knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.tm1_ug.2.0.0.doc/c_tm1_ug_pref_intro.html#tm1_ug_pref_intro)).

---

**TM1 Applications**

Use a web browser on your local computer to run TM1 Applications with your IBM Planning Analytics system.

1. On your local computer, open a web browser and enter the URL for TM1 Applications.
   
   For example, TM1 Applications uses the following URL format:

   `https://customername.planning-analytics.ibmcloud.com/pmpsvc/`

2. Enter the required information on the login page.

   For **User Name** and **Password**, enter your registered IBM ONE ID and password.

3. Click **Login**.

---

**TM1 Applications documentation**
The following documentation for TM1 Applications is available on IBM Knowledge Center:

TM1 Applications ([http://www.ibm.com/support/knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.tm1_cont_ug.2.0.0.doc/c_tm1_applications_intro.html](http://www.ibm.com/support/knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.tm1_cont_ug.2.0.0.doc/c_tm1_applications_intro.html)).

---

**TM1 Operations Console**

You can run TM1 Operations Console from the web browser on your local computer to monitor your TM1 server in your IBM Planning Analytics system.

By default, TM1 Operations Console monitors the default TM1 server named tm1 on your IBM Planning Analytics system. This server is also used for user and group authentication when logging into TM1 Operations Console.

**Default configuration for TM1 Operations Console**

TM1 Operations Console uses the following configuration on your IBM Planning Analytics system:

- admin host: data
- TM1 server: tm1
- TM1 group for authentication: admin
- TM1 user account: your registered IBM ONE ID account

You use this information when logging into the TM1 Operations Console.

**Running TM1 Operations Console with IBM Planning Analytics**

To run TM1 Operations Console, you need the related URL and your registered IBM ONE ID and password.

1. On your local computer, open a web browser and enter the URL that was provided for TM1 Operations Console.

   For example, TM1 Operations Console uses the following URL format:

   `https://customername.planning-analytics.ibmcloud.com/pmhub/pm/opsconsole/`

2. Enter the required information on the login page.

   a. For **Adminhost**, select **data**.
   
   b. For **Servername**, select **tm1**.
   
   c. For **Group**, select **admin**.
   
   d. Enter your IBM ONE ID and password.

3. Click **Login**.
**TM1 Operations Console documentation**
The following documentation for the TM1 Operations Console is available on IBM Knowledge Center:

Cognos TM1 Operations Console installation (https://www.ibm.com/support/knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.tm1_inst.2.0.0.doc/c_tm1_inst_tm1opsconsole_install_intro.html).

Using the IBM Cognos TM1 Operations Console (https://www.ibm.com/support/knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.tm1_op.2.0.0.doc/c_tm1_ops_console_using_heading.html).

---

**TM1 Architect**

IBM TM1 Architect is a desktop application that you run in a remote desktop session with your IBM Planning Analytics system.

To run TM1 Architect on your IBM Planning Analytics system, perform the following steps:

1. Connect to your IBM Planning Analytics system with a remote desktop connection.
   
   For more information, see “Connecting to the IBM Planning Analytics remote desktop” on page 8.

   **Tip:** If the newer Windows Start menu desktop is displayed instead of the classic desktop view, click the Desktop icon or press the Windows logo key to toggle to the classic desktop view.

2. Double-click the desktop shortcut for **Architect**.

3. In TM1 Architect, expand the **TM1** node and double-click the **tm1** server node.

4. Enter your registered IBM ONE ID and password and then click **OK**.

5. If the login is successful, the TM1 server object tree is displayed.

**TM1 Architect documentation**
The following documentation for TM1 Architect is available on IBM Knowledge Center:

- TM1 Perspectives, TM1 Architect, and TM1 Web (http://www.ibm.com/support/knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.tm1_u2.0.0.doc/c_tm1_u2_pref_intro.html%23tm1_u2_pref_intro)
- TM1 Operations (http://www.ibm.com/support/knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.tm1_op.2.0.0.doc/c_preface_tm1_ops.html)

---

**TM1 Perspectives**

TM1 Perspectives is an add-in for Microsoft Excel that you run in a remote desktop session with your IBM Planning Analytics system.

To run TM1 Perspectives on your IBM Planning Analytics system, perform the following steps:

1. Connect to your IBM Planning Analytics system with a remote desktop connection.
   
   For more information, see “Connecting to the IBM Planning Analytics remote desktop” on page 8.

   **Tip:** If the newer Windows Start menu desktop is displayed instead of the classic desktop view, click the Desktop icon or press the Windows logo key to toggle to the classic desktop view.

2. Double-click the desktop shortcut for **Perspectives**.

3. If the Microsoft Excel Security Notice dialog is displayed, click **Enable Macros** to continue.

4. In Excel, on the TM1 menu, click **Connect** to log in to the TM1 Server.

5. Enter the following information in the **Connect to TM1 Server** dialog:

   - For **Server ID**, select **tm1**.
   - For **Client ID**, enter your IBM ONE ID.
   - For **Password**, enter your IBM ONE ID password.
   - Click **OK**.

6. If the login is successful, a confirmation message is displayed.
**TM1 Perspectives documentation**
The following documentation for TM1 Perspectives is available on IBM Knowledge Center:

[TM1 Perspectives, TM1 Architect, and TM1 Web](https://www.ibm.com/support/knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.tm1_ug.2.0.0.doc/c_tm1_ug_pref_intro.html#tm1_ug_pref_intro)

---

**TM1 Performance Modeler**

You can run TM1 Performance Modeler from the remote desktop connection of your IBM Planning Analytics system. To run this component:

1. Connect to your IBM Planning Analytics system with a remote desktop connection.
   
   For more information, see “Connecting to the IBM Planning Analytics remote desktop” on page 8.
   
   **Tip:** If the newer Windows Start menu desktop is displayed instead of the classic desktop view, click the Desktop icon or press the Windows logo key to toggle to the classic desktop view.
2. Double-click the desktop shortcut for **IBM Cognos TM1 Performance Modeler**.
3. In the Connect dialog, make sure the IBM Cognos TM1 system URL field contains the following URL:
   ```
   https://customername.planning-analytics.ibmcloud.com/pmpsvc/services
   ```

   4. Click **Log on as**, enter your registered IBM ONE ID and password, and then click **Login**.
   5. In the TM1 Server drop-down list, select the server that you want to log into, and then click **OK**.
   
   For example, the default TM1 server in the IBM Planning Analytics system is named tm1.

---

**TM1 Performance Modeler documentation**
The following documentation for TM1 Performance Modeler is available on IBM Knowledge Center:

[TM1 Performance Modeler](https://www.ibm.com/support/knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.prfmdl_ug.2.0.0.doc/c_prfmdl_intro.html)

---

**Cognos Command Center**

You can use IBM Cognos Command Center on-premises to automate your TM1 server on the cloud.

**Note:** Cognos Command Center is not available with Planning Analytics Digital Pack.

- You can create a task that combines TI processes with file management. For example, you can create a task that automates a scheduled upload of a data file to the cloud by using FTPS and runs a TI process that imports the data into your IBM Planning Analytics system. The task can then run a second TI process to export the results of the first TI process and download the results back to your local computer.
- You can also use other features of Cognos Command Center. For example, you can parse log files to look for problems and get alerts.
- You can use Cognos Command Center to bridge on-premises and on-cloud activities. You can also manage cloud-to-cloud activities.

**Attention:**

- Because the agent is not a Windows Administrator, you cannot use a Cognos Command Center task to start, stop, or restart the TM1 Server, which runs as a Windows service.
- You cannot use action buttons or TM1 TI scripts to start Cognos Command Center processes because the Cognos Command Center TM1 wrapper is not deployed on the cloud.

When you first use your IBM Planning Analytics system, you are provided with an IBM Planning Analytics Welcome Kit file for each IBM Planning Analytics system that you requested. The IBM Planning Analytics Welcome Kit contains the information that is required to set up an agent in Cognos Command Center and also to set up a computing resource in the Cognos Command Center server.

The Welcome Kit also contains the information that is required to set up a non-interactive user, `<customer>_tm1_automation`, in Cognos Command Center.
Setting up an agent in the Cognos Command Center server

The agent must be added to the IBM Cognos Command Center and its connection properties must be configured in order for the Cognos Command Center server to interact with the agent.

Procedure

1. In the Cognos Command Center navigation tree, click **Setup and Design**.
2. On the **Setup and Design** tab, click **Agents**.
3. To create an agent, either click the **New** icon or right-click the agent item and click **New**.
4. Specify a name for the new agent.
5. Specify the following properties:
   - **Host name** For example, `customername.planning-analytics.ibmcloud.com`.
   - **Port** For example, 443.
   - **Platform** For example, Windows.
   - **Agent user name** For example, `admin`.
   - **Agent password** For example, the fifty-character password included in the IBM Planning Analytics Welcome Kit.
6. Click **Test the Agent** to verify that a connection to the agent is working properly.

Attention:

- The agent must be running on the host for a test connection to work.
- If you see a "Host name exceeds maximum length of 50" warning, enter "cloud.planning-analytics.ibmcloud.com/ccagent/" in the **Host name** field. On the IBM Command Center Server host, edit the `%WINDIR%\system32\drivers\etc\hosts` file and add the following line:

  ```
  Public IP address of your IBM PA environment cloud.planning-analytics.ibmcloud.com
  ```

What to do next

For more information about creating agents, see Agents (http://www.ibm.com/support/knowledgecenter/SSPLNP_10.2.3/com.ibm.swg.ba.cognos.ag_ccc.10.2.3.doc/c_ag_ccc_agents.html).

You can also set up role-based authorization for Cognos Command Center. For more information, see Creating roles (http://www.ibm.com/support/knowledgecenter/SSPLNP_10.2.3/com.ibm.swg.ba.cognos.ag_ccc.10.2.3.doc/t_ag_ccc_create_roles.html).

Setting up a computing resource in the Cognos Command Center server

This computing resource type represents a TM1 server instance.

Procedure

1. In the Cognos Command Center navigation tree, click **Setup and Design**.
2. Click **Ecosystems**.
3. Open an ecosystem. For example, double-click the name of an existing ecosystem in the navigation pane.
4. In the ecosystem editor window, click the **Computing resources** tab.
5. Click the **Add computing resource** icon to add a computing resource.

   A new computing resource editor opens.
6. To add a TM1 computing resource, select **TM1 10.2.2.2 Server** from the **Type** drop-down list.

   The TM1 resource attributes are displayed.
7. Configure the following attributes:

- **Agent** Use the agent that you created in Setting up an agent in the Cognos Command Center server.
- **Home Directory** For example, c:\ccc\your_choice.
- **Server endpoint** The TM1 server endpoint is created by concatenating `hostname + /tm1/api + tm1_server_name + /api/v1`. For example, the following server endpoint connects to the PData TM1 Server:

  ```plaintext
  https://<environmentname>.planning-analytics.ibmcloud.com/tm1/api/PData/api/v1/ 
  ```

- **User name** For example, `your_TM1_user name`.
- **Password** For example, `your_TM1_password`.
- **CAM namespace name** Leave blank.

What to do next

For more information, see TM1 plug-in configuration (http://www.ibm.com/support/knowledgecenter/SSPLNP_10.2.3/com.ibm.swg.ba.cognos.ag_ccc.10.2.3.doc/c_ug_ccc_pi_tm1_1022_configuration.html).

### Setting up a non-interactive account for use in the LDAP namespace

The non-interactive account that is provided in the welcome kit can be used when you use automation tools and processes that are scheduled, or when you need a user name and password that are non-interactive. For example, Cognos Command Center, Cognos Integration Server, and TM1RunTI.

Using the following account, a customer can use Cognos Command Center to automate processes that involve their Planning Analytics Cloud TM1 server.

- **User name**: `customer_tm1_automation`
- **Password**: `generated`
- **CAM Namespace**: LDAP

**Note:**

- This account can be used only from clients where you can specify the namespace. This account cannot be used to log in to the Planning Analytics Workspace.
- This account is disabled by default. It can be enabled upon request.

To configure the TM1 object security for the non-interactive user, the user needs to be added dynamically by logging in for the first time with Cognos Command Center or by using a TI Script. The non-interactive user cannot be added by using Add Client in the UI.

You can use the following TI command to create the non-interactive user:

```plaintext
AddClient('CAMID("LDAP:u:uid=<customer>_tm1_automation,ou=people")');
```

**Note:** The non-interactive user has minimal permissions in Cognos Analytics. When you create the non-interactive user, the user is added to a new user group, the **Non-Administration Users** group in Cognos Analytics, which does not have permission to read, write, or execute packages. When the non-interactive user signs in to Analytics, the user does not have Administrator access.

### Setting up a computing resource for the non-interactive user

This computing resource type represents a TM1 server instance.

**Procedure**

1. In the Cognos Command Center navigation tree, click **Setup and Design**.
2. Click **Ecosystems**.
3. Open an ecosystem. For example, double-click the name of an existing ecosystem in the navigation pane.
4. In the ecosystem editor window, click the **Computing resources** tab.
5. Click the **Add computing resource** icon to add a computing resource.
A new computing resource editor opens.

6. To add a TM1 computing resource, select **TM1 10.2.2.2 Server** from the **Type** drop-down list.

   The TM1 resource attributes are displayed.

7. Configure the following attributes:

   - **Agent** Use the agent that you created in *Setting up a non-interactive account for use in the LDAP namespace*.
   - **Home Directory** For example, `c:\ccc\your_choice`.
   - **Server endpoint** The TM1 server endpoint is created by concatenating `hostname + /tm1/api + tm1_server_name + /api/v1`. For example, the following server endpoint connects to the PData TM1 Server:

     ```
     https://<environmentname>.planning-analytics.ibmcloud.com/tm1/api/PData/api/v1/
     ```

   - **User name** For example, `<customer>_tm1_automation`.
   - **Password** For example, `your_TM1_automation_user_password`.
   - **CAM namespace name** LDAP.

### Connecting on-premises or in the cloud

You can use a local on-premises Cognos Command Center agent and connect to TM1 REST API directly, or you can connect with a cloud agent.

To connect with a cloud agent, you must open up port 61617 in your corporate firewall, which points to the host where the CCC Server resides. This step is required so that the CCC agent on the IBM Planning Analytics server can connect back to CCC Server.

For more information, see the following flow diagram:

![Flow Diagram](image)

### Configuring an on-premises agent

You can configure an agent that resides on an on-premises Cognos Command Center server.

**Tip:** We recommend that you use an on-premises agent instead of an in-cloud agent. This setting allows you to automate TM1, Email, FTP, SFTP, and Oracle tasks in just a few clicks.

**Restriction:** If you use an on-premises agent in the planning analytics cloud environment, you cannot perform these tasks:

- run an executable or a batch file
- monitor networking ports
- manage files

The following diagram shows a Cognos Command Center agent that is configured on an on-premises Cognos Command Center server.
Before you begin
The TM1 9.5.2 plugin is loaded by default. However, only the TM1 10.2.2.2 plugin is compatible with Planning Analytics in the cloud. Therefore, you must load the TM1 10.2.2.2 plugin before you configure the agent.

1. In Cognos Command Center, select Tools > Manage Plugin Tasks.
2. Select the IBM Cognos TM1 10.2.2.2 plugin zip file.
3. Click Open.

Procedure
1. Create an agent. See “Setting up an agent in the Cognos Command Center server” on page 22.
2. Add a computing resource. See “Setting up a computing resource in the Cognos Command Center server” on page 22.
   
   **Note:** In the Server endpoint field, enter a value with this format:
   
   https://hostname.planning-analytics.ibmcloud.com/tm1/api/tm1_server_name/api/v1/

Configuring an in-cloud agent
You can configure an agent that resides in the Planning Analytics cloud.

**Note:** We recommend that you use an on-premises agent instead of an in-cloud agent.

However, with an in-cloud agent, you can perform the following tasks that an on-premises agent cannot run:

- Run an executable or a batch file.
- Monitor networking ports.
- Manage files.

The following diagram shows a Cognos Command Center agent that resides in the Planning Analytics cloud.
Before you begin
You must load the Planning Analytics plugin before you configure the agent.

1. In Cognos Command Center, select **Tools > Manage Plugin Tasks**.
2. Select the **IBM Cognos TM1 10.2.2.2** plugin zip file.
3. Click **Open**.

Procedure
1. Configure the corporate firewall of `subdomain.domain.com`.
   a) Forward inbound traffic TCP port 61617 to 192.168.1.200 port 61617
   
   **Tip:** In this example, 192.168.1.200 is the internal ip address of CCC server.
   b) Submit a ticket to the cloud ops team to find out the IP address of the Planning Analytics data computer.
   c) Block all inbound traffic except traffic that comes from the Planning Analytics cloud computer for port 61617.
   
   **Note:** Port 61617 is used by CCC Queue in this document. You specify this port number when you install Cognos Command Center.
2. Configure the Cognos Command Center Queue.
   a) In the Cognos Command Center client, select **Tools > System Configuration**.
   b) Click the **Queue** subsystem.
   c) For the **External URI** property, update the value of `subdomain.domain.com`
3. Modify the file `activemq.xml`.
   a) Open the file `activemq.xml`, which is located in `installation_directory\IBM\Cognos Command Center\Common\apache-activemq-5.8.0\conf`\n   b) In the object `transportConnector`, replace the value of the `uri` attribute with the following text: "ssl:// 0.0.0.0:61617?transport.enabledProtocols=TLSv1,TLSv1.1,TLSv1.2"
   c) Save the file `activemq.xml`.
   d) Restart both the **IBM Cognos Command Center Queue** and the **IBM Cognos Command Center Server** Windows services.
4. Create an agent. See “Setting up an agent in the Cognos Command Center server” on page 22.
   
   **Tip:** If you receive the following error, revisit Step 1.
   Failed to receive reply event from agent through the message queue. Timeout while waiting on event from agent.
5. Add a computing resource. See “Setting up a computing resource in the Cognos Command Center server” on page 22.
Note: In the **Server endpoint** field, enter a value with this format:

https://hostname.planning-analytics.ibmcloud.com/tm1/api/tm1_server_name/api/v1/

**Cognos Command Center documentation**

You can read more about Cognos Command Center.


**Running IBM Cognos Analytics with IBM Planning Analytics**

You can choose to run IBM Cognos Analytics in your Planning Analytics environment.

**Note:** Cognos Analytics is an optional component. It is not available with Planning Analytics Digital Pack.

If you requested that IBM Cognos Analytics be included with your Planning Analytics environment, the Welcome Kit contains the information that you need to set up Cognos Analytics.

For more information, see “IBM Planning Analytics account and system information” on page 6.

**Adding your Cognos Analytics user account to the Planning Analytics server**

After you log in as a Cognos Analytics user, you can add your user account to the Planning Analytics server in one of two ways:

- You can create a Planning Analytics data source.
- You can replace an existing connection to a TM1 data source with a Planning Analytics data source connection.

**Creating a Planning Analytics data source as a Cognos Analytics user**

Procedure

1. In IBM Cognos Administration, on the **Configuration** tab, select **Data Source Connections**.
2. Select the new data source button.
3. In the name and description page, type a unique name for the data source and, optionally, a description and screen tip, and then select **Next**.
4. In the connection page, from the **Type** drop-down list, select **IBM Planning Analytics**.
5. Specify the connection parameters.
   a. In the **Host** field, enter the Cognos Analytics Administration server listed in your Welcome Kit.
   b. In the **Server Name** field, enter the Cognos Analytics server name.
   c. Select **Signons**.
   d. Enter your Cognos Analytics user name and password.
   e. Click **Confirm**.
6. Select **Test the connection**, and then **Test** to test whether parameters are correct.
7. Click **Finish**.

The new data source appears in **Data Source Connections** on the **Configuration** tab.

Your Cognos Analytics user information now appears on the TM1 server.

**Replacing an existing TM1 data source connection with a Planning Analytics data source connection**

Procedure

1. Follow the steps to create a Planning Analytics data source.
2. Re-publish any packages that refer to the existing TM1 data source.
3. IBM Cognos Administration, remove the TM1 data source by selecting its check box and then select the delete button.
Creating a Planning Analytics data source as a Planning Analytics user

If you are logged in as a Planning Analytics user, you can create a Planning Analytics data source in Cognos Analytics.

Procedure
1. In IBM Cognos Administration, on the Configuration tab, select Data Source Connections.
2. Select the new data source button.
3. In the name and description page, type a unique name for the data source and, optionally, a description and screen tip, and then select Next.
4. In the connection page, from the Type drop-down list, select IBM Planning Analytics.
5. Specify the connection parameters.
   a) In the Host field, enter the Cognos Analytics Administration server listed in your Welcome Kit.
   b) In the Server Name field, enter the Cognos Analytics server name.
   c) Select No authentication.
   d) Click Confirm.
5. Select Test the connection, and then Test to test whether parameters are correct.
6. Click Finish.

Results
The new data source appears in Data Source Connections on the Configuration tab.

Assigning user permissions with TM1 security

After users are added to the TM1 server, you can assign each user appropriate permissions using TM1 security.

Note: If you also subscribe to Cognos Analytics on Cloud, you do not need non-interactive account specific configuration to use components such as Cognos Command Center (CCC) and Cognos Integration Server (CIS). Instead, you can use the Cognos Analytics on Cloud namespace to run CCC and CIS.

Procedure
1. Understand that you can assign users to groups that have different permissions.
2. Understand the roles of each administrator group.
3. Create groups with different levels of permissions.
4. Assign users to the groups that you defined.
Chapter 3. IBM Planning Analytics modeling tasks

As a modeler for your IBM Planning Analytics system, you should understand the steps that are unique to the cloud environment, such as uploading and managing files, and migrating data in your IBM Planning Analytics system.

Managing TM1 Servers using the Control command

Run the IBM Planning Analytics Control command to perform some management tasks yourself for the TM1 Servers on the IBM Planning Analytics system. Other tasks require assistance from IBM Support.

You can run the Control command to help you with these tasks:

- stopping and starting TM1 servers
- updating content on your Planning Analytics system
- connecting to data using a Secure gateway

Note: If you want to create a new TM1 Server instance or remove an existing TM1 Server instance on the IBM Planning Analytics system, contact IBM Support. For new TM1 Servers, this will ensure that the correct security, recovery, and connections are set up.

Running IBM Planning Analytics Control

To run IBM Planning Analytics Control, you need the related URL and the admin account provided in your Planning Analytics Welcome Kit.

Procedure

1. On your local computer, open a web browser and enter the URL that was provided for IBM Planning Analytics Control.
   
   For example, IBM Planning Analytics Control uses the following URL format:
   
   https://customercname.planning-analytics.ibmcloud.com/control

2. Enter the admin account userid, such as admin, with the provided password.

3. Click Login.

Results

The IBM Planning Analytics Control window is launched.

Stopping and starting TM1 Servers

Occasionally you might need to stop and restart a TM1 Server instance in the IBM Planning Analytics system.

To do this, use the IBM Planning Analytics Control command.

Procedure

1. On your local computer, open a web browser and enter the URL for IBM Planning Analytics:
   
   https://customercname.planning-analytics.ibmcloud.com/control/

2. Enter the login information.
   
   a) In the User Name field, type control.
   
   b) In the Password field, enter the password for the control user account that was included in the IBM Planning Analytics Welcome Kit.

   The IBM Planning Analytics Control window is launched.
3. Click the cube icon in the left pane to show the **TM1 Servers** page.

All of the TM1 servers that are configured in your Planning Analytics system appear as tiles. Each tile is colored to represent the server status:

- A green tile indicates that the server is running.
- A red tile indicates that the server is stopped.
- An orange tile indicates that the server has been temporarily suspended, likely due to a crash situation.

**Tip:** When a crash situation occurs, a memory dump file is written to the cloud server. After the memory dump file is created, the server status changes to **Stopped** and you can restart the server. If the orange tile does not change to red, you should contact IBM Support. Please note the approximate time and date of the server crash for the Support team to reference.

4. For any of the running or stopped TM1 servers, click a button as required.

- If you want to stop a TM1 Server instance to make content changes, click **Stop**.
- If the status message stays at **Stop Pending** for more than five minutes without changing to **Stopped**, click **End Process**.

  **Note:** When you click **End Process**, any data that was not logged is lost.
- To resume running the TM1 Server, click **Start** or **Restart**.

### Updating content on the IBM Planning Analytics system

Use Remote Desktop to upload content files and load the data into your default TM1 server on your IBM Planning Analytics system.

**Procedure**

1. Connect to your IBM Planning Analytics system with a remote desktop connection.
   
   For more information, see “Connecting to the IBM Planning Analytics remote desktop” on page 8.

   **Tip:** If the newer Windows Start menu desktop is displayed instead of the classic desktop view, click the **Desktop** icon or press the Windows logo key to toggle to the classic desktop view.

2. Upload your updated files to a temporary folder on the remote desktop.

   a) Open Microsoft Windows File Explorer in the remote desktop session.

   **Tip:** The Windows Explorer tool was renamed to File Explorer in Windows Server 2012 R2.

   b) Create a temporary folder on the remote desktop.

   c) Copy the files from File Explorer on your local desktop to the temporary folder that you created on the remote desktop.

   **Tip:** You can also use **File Transfer Protocol (FTP)** to copy your local files to the IBM Planning Analytics system.

3. Stop the TM1 Server for which you are updating content.

   - Run the **Control command**.
   - For each affected TM1 Server, click **Stop**.

4. In the Remote Desktop window, copy the uploaded files into the server's data folder.

   For example, copy the files from the temporary folder into the folder `\data\s\prod\tm1`.

   **Important:** Do not delete any existing folder that represents one of your TM1 Servers, for example `\data\s\prod\tm1`. Any folder that represents a service contains the file `tm1s.cfg`.

5. Start the TM1 Servers.

   - Go to the **TM1 Cloud Control** window.
   - For each stopped TM1 Server, click **Start**.
Managing a secure gateway

You can use IBM Secure Gateway to create and manage a secure connection between your on-cloud Planning Analytics environment and your on-premises data sources.

Planning Analytics commonly contains source data representing summarized transaction data from ERP systems. These source systems are typically relational and accessed via ODBC using TurboIntegrator. The Secure Gateway allows your Planning Analytics components to interact seamlessly and securely with your on-premises ODBC data sources.

You must create a Secure Gateway if you want to access ODBC data sources on-premises using TurboIntegrator. This is useful for importing data into TM1, exporting data to the ODBC source, and drilling through to transactional data.

Note: For more information about IBM Secure Gateway, see Secure Gateway overview.

Watch videos about IBM Secure Gateway

The following videos show you how to use IBM Secure Gateway:

- Hybrid planning with IBM Planning Analytics: The Secure Gateway
- Creating an IBM Secure Gateway
- Adding a data source to your IBM Secure Gateway
- Connecting to your IBM Secure Gateway via Docker

Creating an IBM Secure Gateway

Create an IBM Secure Gateway to establish a secure connection between your on-cloud Planning Analytics environment and your on-premises data sources.

Before you begin
Before you can create a Secure Gateway, you must install a supported Secure Gateway client.

Note: The following example procedure leverages the Docker Secure Gateway client.

Procedure
1. Ensure that a Secure Gateway client is installed.
2. Set up your on-premises database.
3. Log in to IBM Planning Analytics Control.
4. Click the padlock icon in the left pane.
5. Click the Create Secure Gateway tile.
6. Enter a name for your Secure Gateway.
7. If you want increased security for who is authorized to start the gateway, leave the Enforce Security Token check box selected.
8. Click Create. The creation is confirmed and instructions appear in the Create Secure Gateway window.
9. Follow the instructions to connect the Secure Gateway using the Docker Secure Gateway client.

Results
A message confirms that the Secure Gateway tunnel is connected.
The Secure Gateway is represented as a square tile in the **Secure Gateways** window. The tile displays the following information:

- the Secure Gateway name
- the Secure Gateway’s status

**Tip:** When the status **CONNECTED** is displayed, the tile is green. When the status **DISCONNECTED** is displayed, the tile is red.

To reconnect a disconnected Secure Gateway,

1. Click the red tile with **DISCONNECTED** displayed.
2. In the **Overview** pane, click **Show Details**.
3. Copy either the **Docker Command** string or the **Docker Command with Secure Token** string and run it in a command window.

- the number of data sources that the Secure Gateway is connected to
- an ellipsis (...) button that you can click to edit or view the Secure Gateway details; disable or enable the Secure Gateway; or delete the Secure Gateway.

**Add a data source to the Secure Gateway**
Add a data source to the IBM Secure Gateway to establish a secure connection between your on-cloud Planning Analytics environment and your on-premises data sources.

**Procedure**

1. Ensure that an IBM Secure Gateway is created and connected.
2. Set up your on-premises database.
3. **Log in to IBM Planning Analytics Control.**

   4. Click the padlock icon in the left pane.
5. Click the tile representing the Secure Gateway.
   
   An Overview pane appears.

   **Tip:** To view Gateway information, click **Show Details**. To view the amount of inbound and outbound data over the last 24 hours, click **Show Usage**.

6. In the **Data Sources** pane, click the **Add Data Source** button.
7. Enter the Data Source name, the host name or IP address, the port, the protocol and then click **Add**.
   
   A message confirms that you added the data source successfully.
8. Enter the driver, database name, description, the trusted connection option, and then click **Create DSN**.
   
   A message confirms that you configured the DSN successfully.
9. To test the DSN connection, enter your username and password and click **Test DSN**.
   
   If the test is successful, your Data Source connection is complete and you can start using your Secure Gateway.

   The data source connection is represented as a square tile in the **Data Sources** window. The tile displays the following information:

   - the data source name
   - the data source's status
   - an ellipsis (...) button that you can click to edit or view the data source details; disable or enable the data source; or delete the data source.

   **Tip:** The Docker console shows connection traffic information when the Secure Gateway is being used.

**Renewing a secure token**
You can set the expiration date of the secure token that authorizes access to an IBM Secure Gateway instance.
Procedure

1. Log in to IBM Planning Analytics Control.

2. Click the padlock icon in the left pane.
   The Secure Gateways window appears, containing one tile for each Secure Gateway.
   
   Tip: If a secure token has expired, it is indicated on the tile.

3. On the tile for the Secure Gateway instance, click the ellipsis (...) in the upper right corner.

4. Click Edit / View.
   The gateway_name Details window appears.

5. Click Renew Secure Token.
   A new date appears in the Secure Token Expiration section.
   
   Note: The new expiration date is three years from the current date.

6. Copy the value in the Gateway Key field.

7. On the computer where the Secure Gateway client is installed, in a text editor, open this file:
   
   C:\Program Files (x86)\Secure Gateway Client\ibm\securegateway\client\securegw_service.config

8. In the SECTOKEN line, replace the value of only the associated secure gateway instance with the Gateway Key value that you copied in step “6” on page 33.
   
   Note: Multiple values for SECTOKEN are separated by two dashes (--). The order of the SECTOKEN values matches that of their associated GATEWAY_ID values.

   Example:

   If there are two secure gateways, named my_secure_gateway_1 and my_secure_gateway_2, the file securegw_service.config.txt might include this text:

   ```
   #Enter the gateway ids separated by single spaces
   GATEWAY_ID=my_secure_gateway_1 my_secure_gateway_2

   #Enter the security tokens separated by --

   SECTOKEN=eyJhbGciOiJIUzI1NiIsInR5cCI6IkpXVCJ9.eyJjb25maWd1cmF0aW9uZyIsInJlZ2lvdXNvbXRoIiwiaWF0IjoxNTUxMjYyMzY2LCJleHAiOjE0NDQwOTYxMzIyfQ.89gPNMEAn-OfvvCjiivgTtprk4QAFq2G_zg8B9owW9uX21
   
   iOUM2OURvZEQ2VmNfcHJvZFRuZyiIsInJ1Z2lvdXNvbXRoIiwiaWF0IjoxMDcwOTMzMDY0LCJleHAiOjE0NDQwOTYxMzY2fQ.89gPNMEAn-OfvvCjiivgTtprk4QAFq2G_zg8B9owW9uX21
   
   xiHYiiGci0jIUzI1NiIsInR5cCI6IkpXVCJ9.eyJjb25maWd1cmF0akIjoibOUM2OURvZEQ
   
   2VmNfcHJvZFRuZyiIsInJ1Z2lvdXNvbXRoIiwiaWF0IjoxMDcwOTMzMDY0LCJleHAiOjE0NDQwOTYxMzY2fQ.89gPNMEAn-OfvvCjiivgTtprk4QAFq2G_zg8B9owW9uX21
   
   InVzLNvdXRoIiwiaWF0IjoxMDcwOTMzMDY0LCJleHAiOjE0NDQwOTYxMzY2fQ.89gPNMEAn-OfvvCjiivgTtprk4QAFq2G_zg8B9owW9uX21
   
   If you renew the secure token for my_secure_gateway_2, it is associated with the second value for GATEWAY_ID. You would then replace only the second SECTOKEN value (shown in bold text above) with the Gateway Key value that you copied in step “6” on page 33.

Managing TM1 user accounts that use native security

As a modeler for your IBM Planning Analytics system, you are responsible for creating and maintaining the necessary TM1 user accounts that are required for your company.

If you are using native security (mode 1) in your IBM Planning Analytics system, you can use TM1 Architect or TM1 Performance Modeler to create and manage TM1 users and groups.

Procedure

1. To manage user accounts with TM1 Architect:
   a) Run TM1 Architect in the remote desktop session of the IBM Planning Analytics system.
      For details, see “TM1 Architect” on page 20.
   b) Log in to the TM1 server.
   c) Right-click the tm1 node and select Security > Clients/Groups.
   d) Use the Clients/Groups tool to manage users.
      For more information about managing users and groups with TM1 Architect, see TM1 Operations (https://www.ibm.com/support/knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.tm1_op.2.0.0.doc/c_preface_tm1_ops.html).

2. To manage user accounts with TM1 Performance Modeler:
   a) Run TM1 Performance Modeler in the remote desktop session of the IBM Planning Analytics system.
      For details, see “TM1 Performance Modeler” on page 21.
   b) In the Model Design pane, right-click data.tm1 and select Configure Security > Define Users and Groups > Users and Groups.
   c) Use the ClientGroups tool to manage users.
      For more information about managing users and groups with TM1 Performance Modeler, see TM1 Performance Modeler (https://www.ibm.com/support/knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.prfmdl_ug.2.0.0.doc/c_prfmdl_intro.html).

Managing files in the IBM Planning Analytics shared folder

You can manage files in your shared folder either remotely or directly within a desktop session of the cloud. If you have multiple cloud environments, you can also move files between the shared folders of each environment.

This video shows you how to access the shared folder:

https://youtu.be/-7nE0B5LqcE

Depending on your local and cloud environment, you can use one or more of the following methods to manage your files in the shared folder.

Accessing the shared folder from your local computer

If you want to connect to the shared folder from a remote computer, use a file transfer protocol (FTP) application that supports File Transfer Protocol Secure (FTPS). This will allow you to securely move files between your local computer and the shared folder on the IBM Planning Analytics system.

Use the FTP application with the shared folder address that was provided in the IBM Planning Analytics Welcome Kit. For example:

customername.planning-analytics.ibmcloud.com

For more information, see “Copying local files to IBM Planning Analytics” on page 35.
Using the shared folder in a remote desktop session

If you want to access the shared folder from within the remote desktop session on the IBM Planning Analytics system, use the following path:

\data\s

For example, open the Microsoft Windows File Explorer in the remote desktop session and enter \data\s as the path.

Tip: The Windows Explorer tool was renamed to File Explorer in Windows Server 2012 R2.

Moving files between shared folders of multiple cloud environments

If you want to connect to the shared folder of another IBM Planning Analytics environment, use the x.x.x.x address that was provided to you.

For example, to move files between two cloud environments the general steps include:

1. Start a remote desktop connection to the first cloud environment.
2. Open Microsoft Windows File Explorer in the remote desktop session of the first cloud environment and enter \\data\s.
3. Open a second instance of File Explorer in the same remote desktop session and enter the x.x.x.x address for the other cloud environment.
4. Use File Explorer to copy and paste files between the shared folders of these two cloud environments.

Copying local files to IBM Planning Analytics

Your IBM Planning Analytics system includes a dedicated shared folder for storing and transferring data files. You can copy files between your local computer and the IBM Planning Analytics system shared folder with a File Transfer Protocol Secure (FTPS) application.

Before you begin

You must have your IBM Planning Analytics system account information.
You also need an FTP application that supports File Transfer Protocol Secure (FTPS) to securely copy files from your local system to the IBM Planning Analytics system.

Important: To ensure that your data is encrypted when transferred, the Planning Analytics system FTP connection is configured to use FTP with Secure Sockets Layer (FTPS). Make sure to use an FTP application that supports FTPS.

Procedure

1. On your local computer, open your FTP application and enable the option to use File Transfer Protocol Secure (FTPS).
2. Enter the information for the connection:
   a. Enter the address for the shared folder on your IBM Planning Analytics system.
      For example:
      customername.planning-analytics.ibmcloud.com
   b. Enter the user name of FileShare and the assigned password for the cloud shared folder.
3. Use the FTP application to select and move files between your local computer and the IBM Planning Analytics system.
4. Log out of the FTP session and close the FTP application.

PGP encryption

Use PGP encryption to encrypt files that are transferred to the cloud or to encrypt files on the cloud that are to be transferred to on-premises.

Note: All data that is transferred to and from the cloud is encrypted in transit regardless if the PGP encryption feature is enabled.
Before you begin

Install a PGP application, for example GnuPGP (from https://www.gnupg.org/download) or Symantec Encryption Desktop (from https://www.symantec.com), in your on premises environment.

Setting up encryption/decryption
1. Send a service request to IBM Support and ask that PGP encryption be enabled and configured.
2. Connect to the IBM Planning Analytics remote desktop using one of the modeler accounts listed in your Welcome Kit.
3. In the shared folder, go to \data\s\install\encryption\samples.
4. Copy *.pro to your tm1 server data directory (for example, S:\prod\tm1\Data).
5. Copy *.txt and *.bat to the server directory (for example, S:\prod\tm1).
6. Restart your tm1 server for the demo processes to appear.

   **Note:** The *.pro processes will have access to the IBM passphrase regardless of additional shared folder file security that may be defined.

Transferring encrypted files to the cloud and then decrypting them before import
1. Encrypt a file (originally named filename.extension) in your on premises environment using the PGP application that you installed locally.
   a. Use the public key that was attached to your Welcome Kit and that you imported into your key rings.
   b. Name the encrypted file filename.extension.gpg.
   c. Name the recipient customer@ibm.com.
2. Copy filename.extension.gpg from your on premises location to the Planning Analytics server directory (for example, S:\prod\tm1).
3. Connect to the IBM Planning Analytics remote desktop using one of the modeler accounts listed in your Welcome Kit.
4. Edit the file demo_decryption.bat and replace two instances of the string customer_to_ibm.txt with filename.extension.
5. Start Architect, and run the process demo_decryption.pro.
   The decrypted file, named filename.extension, appears next to filename.extension.gpg.
6. Import the decrypted file into IBM Planning Analytics as required.
   For example, import the data using TurboIntegrator.

Encrypting files on the cloud before transferring them to on premises
1. Send a service request to IBM Support.
   a. Attach your public key to the request.
   b. Request that your public key be imported.
2. Connect to the IBM Planning Analytics remote desktop using one of the modeler accounts listed in your Welcome Kit.
3. In IBM Planning Analytics, extract data and save it to a server directory (for example, S:\prod\tm1) as the file filename.extension.
4. Edit the file demo_encryption.bat.
   a. Replace firstname.lastname@mycompany.com with the name in your key.
   b. Replace two instances of the string customer_to_ibm.txt with filename.extension (the file that you want to encrypt).
5. On the remote desktop, start Architect, and run the process demo_encryption.pro.
   The encrypted file, named filename.extension.gpg, appears next to filename.extension.
6. Copy the encrypted file filename.extension.gpg from the Planning Analytics server directory to your on premises location.
7. Decrypt the file in your on premises location using the PGP application that you installed locally.
Loading and migrating data with IBM Planning Analytics

Migrating data from your development environment to your production environment with IBM Planning Analytics is a process that requires careful planning and should be performed in stages. The exact steps for data migration depend on a number of factors, such as where your development and production environments are located and what type of data is being moved.

As a TM1 modeler, you can perform the following data migration tasks:

- Upload files from your local computer to the shared folder in your non-production or production IBM Planning Analytics system.
- Move files between the shared folders of your non-production and production IBM Planning Analytics systems.
- Manually copy TM1 Websheet files to the shared folder.

**Important:** You must stop and restart your TM1 Server when copying TM1 server database files to the data directory.

On an ongoing basis, you can perform the following tasks:

- Use the Transfer tool in TM1 Performance Modeler to export and import metadata changes between development and production environments.

  For more information, see Transfer of model objects and applications in *TM1 Performance Modeler* (http://www.ibm.com/support/knowledgecenter/SS9RXT_10.3.0/com.ibm.swg.ba.cognos.prfmdl_ug.10.3.0.doc/c_prfmdl_importing_transferring_data.html).

- Use TurboIntegrator processes to load bulk data into your production environment.

  For more information, see *TM1 TurboIntegrator* (http://www.ibm.com/support/knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.tm1_turb.2.0.0.doc/c_preface_n90007.html).
Appendix A. Frequently asked questions

This section answers some common questions that customers might have about IBM Planning Analytics.

**Can I change the tm1s.cfg file?**

Yes, you can modify the tm1s.cfg file. However, you must use the version that is provided with the Cloud deployment. This Cloud version has settings specific to Planning Analytics, such as the TM1 Server port number. Do not use a customer’s existing tm1s.cfg file if you are moving their TM1 model to the cloud. Some of the settings require a server restart before they become effective. Use the IBM Planning Analytics Control command to start or stop the TM1 Server.

**Important:** Do not modify the following parameters in the tm1s.cfg file, otherwise your deployment will break:

- UseSSL
- CAMUseSSL
- SSLCertificateID
- SSLCertAuthority
- ClientCAMURI
- ServerCAMURI
- DatabaseDirectory
- LoggingDirectory
- ServerName
- PortNumber
- MessagePortNumber
- HTTPPortNumber

**Have there been any changes to TM1 configuration parameters since 10.2.2?**

Yes, parameters have been added to the TM1 server configuration file (tm1s.cfg), the TM1 Web configuration file (tm1web_config.xml), and the TM1 client configuration file (tm1p.ini) since 10.2.2. This section covers changes that were made after the 10.2.2.3 version of the **TM1 Installation and Configuration Guide** was published.

The following tables list parameters that were added in TM1 10.2.2.3 and TM1 10.2.2.4.

<table>
<thead>
<tr>
<th>Table 1: New tm1s.cfg parameters in 10.2.2.3 and 10.2.2.4</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>New tm1s.cfg parameter</strong></td>
</tr>
<tr>
<td>MDXSelectCalculatedMemberInputs (10.2.2.4)</td>
</tr>
<tr>
<td>SpreadErrorInTIDiscardsAllChanges (10.2.2.3)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Table 2: New tm1web_config.xml parameters in 10.2.2.3 and 10.2.2.4</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>New tm1web_config.xml parameter</strong></td>
</tr>
<tr>
<td>ActionButtonFullRecalculationEnabled (10.2.2.4)</td>
</tr>
<tr>
<td>MixedCellPaste (10.2.2.3)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Table 3: New tm1p.ini parameters in 10.2.2.3 and 10.2.2.4</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>New tm1p.ini parameter</strong></td>
</tr>
<tr>
<td>DisableAdminHostEntry (10.2.2.4)</td>
</tr>
</tbody>
</table>

The following table lists tm1s.cfg parameters that have changed in 10.3.
Table 4: tm1s.cfg parameters that have changed in 10.3

<table>
<thead>
<tr>
<th>tm1s.cfg parameter</th>
<th>Change in 10.3</th>
</tr>
</thead>
<tbody>
<tr>
<td>AuditLogOn</td>
<td>Changed to Dynamic</td>
</tr>
<tr>
<td>ClientCAMURI</td>
<td>Changed to Dynamic</td>
</tr>
<tr>
<td>ClientPingCAMPassport</td>
<td>Changed to Dynamic</td>
</tr>
<tr>
<td>ClientPingCAMPassport</td>
<td>Default value changed to 900</td>
</tr>
<tr>
<td>ExcelWebPublishEnabled</td>
<td>Changed to Dynamic</td>
</tr>
<tr>
<td>IntegratedSecurityMode</td>
<td>Changed to Dynamic</td>
</tr>
<tr>
<td>JobQueueMaxWaitTime</td>
<td>Changed to Dynamic</td>
</tr>
<tr>
<td>JobQueueThreadSleepTime</td>
<td>Changed to Dynamic</td>
</tr>
<tr>
<td>LogReleaseLineCount</td>
<td>Changed to Dynamic</td>
</tr>
<tr>
<td>MaskUserNameInServerTools</td>
<td>Default value changed to TRUE</td>
</tr>
<tr>
<td>MTQ</td>
<td>Default value changed to ALL</td>
</tr>
<tr>
<td>PerformanceMonitorOn</td>
<td>Changed to Dynamic</td>
</tr>
<tr>
<td>RawStoreDirectory</td>
<td>Changed to Dynamic</td>
</tr>
<tr>
<td>ServerCAMURI</td>
<td>Changed to Dynamic</td>
</tr>
<tr>
<td>ServerCAMURIRetryAttempts</td>
<td>Changed to Dynamic</td>
</tr>
<tr>
<td>ServerCAMURIRetryAttempts</td>
<td>Default value changed to 3</td>
</tr>
<tr>
<td>ServerLogging</td>
<td>Changed to Dynamic</td>
</tr>
<tr>
<td>UseLocalCopiesforPublicDynamicSubsets</td>
<td>Changed to Dynamic</td>
</tr>
</tbody>
</table>

For all other parameters, see Parameters in the tm1s.cfg file, TM1 Web Parameters, and Parameters in the tm1p.ini file.

**What TM1 Servers are set up initially?**
A single blank TM1 server, with the name TM1, is set up initially when the system is provisioned.

**Note:** Currently, this default TM1 server cannot be renamed or removed.

**How do I set up new TM1 Servers?**
To set up additional TM1 servers, send a request to the Cloud Operations team by creating a PMR. Provide the name of the TM1 Server that you require. After the TM1 Server is set up by the Cloud Operations team, they will send you an email with a new welcome kit. The welcome kit contains the details of the new server, such as the server name and the native TM1 login and password.

The customer can now use the server as is or change the directory structure to organize the TM1 objects in a specific way. By default, all objects will reside in the base directory.

The best practice is to create a folder structure to that shown in the following figure.
In this example, the name of the tm1 application/server in this case is smartco. Note that the default server was named TM1. Therefore, for this tm1 server, the base directory is: ```\data\s\prod\smartco```.

**Important:** The following conditions must all be met:

- The `tm1s.cfg` file must exist in the base directory.
- Any folders that you create must be below the base directory.
- The location or the name of the base directory cannot be changed.

Typically, customers create additional folders with these names:

- Excel - This folder contains Perspectives Report/Template definitions for TM1 Web.
- Files - This folder is used to transfer .txt data files.

**How can I migrate my existing TM1 Server content and settings to the Cloud?**

You can migrate your existing TM1 server content and settings to the Cloud by following these steps:

1. Create a PMR for the Cloud Operations team to set up a new server. See “How do I set up new TM1 Servers?” on page 40.

   **Note:** Use the `tm1s.cfg` file that is provided by IBM. Do not use your existing `tm1s.cfg` file.

2. Delete the default TM1 objects from the new TM1 server.

3. Copy the TM1 objects from your existing TM1 data directory to the data directory in the new TM1 server.

4. Add an existing Cognos user to the Cognos TM1 ADMIN group to act as the administrator. For more information, see Defining a Cognos user to function as a Cognos TM1 administrator (https://www.ibm.com/support/knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.tm1_inst.2.0.0.doc/t_tm1op_defcamuser.html).

   **Tip:** All Planning Analytics user accounts are already configured by default with Cognos security mode 5. For more information, see “Loading and migrating data with IBM Planning Analytics” on page 37.

**How do I access text files in Architect, TurboIntegrator or Performance Modeler?**

When you specify access to text files, select the **Data Source** tab and ensure that the values for **Data Source Name** and **Data Source Name on Server** are different. See the following table.

<table>
<thead>
<tr>
<th>Name of text box on Data Source tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Source Name</td>
<td>This is the path used by Architect and Performance Modeler when you run remote desktop. The full path is required. For example, type <code>\data\s\prod\tm1\data\Integration\OracleGLSubAccountDim.csv</code></td>
</tr>
<tr>
<td>Name of text box on Data Source tab</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| Data Source Name on Server          | This is the path used by TurboIntegrator processes on the TM1 Server. The path should be relative to the TM1 data directory, although absolute paths are possible using S:...  
**Important:** If you enter `\data\` as the **Data Source Name on Server** value, the TI process will fail.  
For example, type `.\Integration\OracleGLSubAccountDim.csv` |

**Note:** All files must reside on the Shared Drive for these reasons:

- The TM1 Server cannot see the Remote Desktop file system.
- Only the shared drive is backed up. Therefore, you risk losing your data if you store files on the remote desktop disk drive.

This video shows you how to access text files:

https://youtu.be/Yd3656YEFTA

**How do I restore data from a backup?**

To restore data from a backup, contact the Cloud Operations team. The Cloud Operations team performs daily backups of the data in your shared folder. They retain the last seven daily backups and an additional four weekly backups.

**Important:** Ensure that your data resides in your shared folder. Any files that are stored in a location other than the shared folder will not be backed up.
Appendix B. Technical considerations

There are some technical considerations that you should be aware of while using IBM Planning Analytics.

Replication and synchronization

IBM Planning Analytics does not currently support or test the TM1 replication and synchronization (rep and sync) feature.

Even though the options for replication and synchronization might appear in the user interface of components with Planning Analytics, this feature is not supported in the cloud environment.

System time zone and clock settings

The IBM Planning Analytics system clock is set to Coordinated Universal Time (UTC). UTC is a universal time standard that is used across the internet, networks, online services, and computer servers.

You cannot change the time zone for the Planning Analytics system. Your user account for the Microsoft Windows desktop environment in the Planning Analytics system does not have sufficient rights to change the time zone.

However, you can add additional clocks in the Planning Analytics system that display when you hover the mouse over the clock in the Windows system tray taskbar. You can also choose to remove the clock from the Windows taskbar.

For more information about adding additional clocks, search the internet for "Windows Server 2012 additional clocks".

TurboIntegrator ASCIIOutput and TextOutput functions

Use a relative path in your TurboIntegrator (TI) processes to export data to your shared folder on the IBM Planning Analytics system.

The ASCIIOutput and TextOutput TI functions do not work with the output path of `\data\s` on the Planning Analytics system. Instead, use `./` to indicate a relative path to the TM1 data directory and shared folder on your Planning Analytics system.

For example, the following TI code sample does not work on the Planning Analytics system:

```
ASCIIOutput('\\data\s\prod\test.txt',test output);
```

The following code samples do work on the Planning Analytics system. These samples write output to a user-created folder named temp in the data directory:

```
ASCIIOutput('./temp/test1.txt','test output 1');
TextOutput('./temp/test2.txt','test output 2');
```

For more information about these TI functions, see ASCII and Text TurboIntegrator Functions in TM1 Reference (http://www.ibm.com/support/knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.tm1_ref.2.0.0.doc/c_asciiandtextturbointegratorfunctions_n706d4.html%23ASCIIandTextTurboIntegratorFunctions_N706D4).

TM1 Architect display issue

In some scenarios, running TM1 Architect or Server Explorer in the desktop session of the IBM Planning Analytics system causes the expand and collapse icons (+ and - symbols) in the object tree pane to disappear.

If this display issue happens, you cannot expand the object nodes in the tree and access your TM1 data objects.

As a workaround, close and reopen TM1 Architect or Server Explorer to correct the display.
**Viewing the Message log in TM1 Architect**

Viewing the Message log in TM1 Architect with IBM Planning Analytics requires a workaround.

When you click **Server > View Message Log**, the following error displays: "Error opening the log file".

As a workaround, use a text editor, such as Windows Notepad, to open and view the `tm1server.log` file from the `\data\s\prod\tm1` shared folder location.

**Accessing the TM1 REST API**

You can access the TM1 REST API in your IBM Planning Analytics environment.

TM1 REST API is enabled in your Planning Analytics environment. You access it by entering a URL that ends with the string `/api/v1/$metadata`.

**Example**

For example, a TM1 model is configured in the server environment `myserver.planning-analytics.ibmcloud.com`, in the location `tm1/api/Planning Sample`. To access the TM1 REST API, type the following text:

```
https://myserver.planning-analytics.ibmcloud.com/tm1/api/Planning Sample/api/v1/$metadata
```

For more information, see TM1 REST API (http://www.ibm.com/support/knowledgecenter/en/SSD29G_2.0.0/com.ibm.swg.ba.cognos.tm1_rest_api.2.0.0.doc/c_preface_tm1_odata.html).
Appendix C. Accessibility features

Accessibility features help users who have a physical disability, such as restricted mobility or limited vision, to use information technology products.

Keyboard shortcuts

Standard Microsoft Windows navigation keys are used in addition to application-specific keys.

You can use keyboard shortcuts to navigate through the application and perform tasks. If you are using a screen reader, you might want to maximize your window so the keyboard shortcut table is completely expanded and accessible. You might want to turn high contrast on in your operating system so the lines in diagrams and charts in the application are more visible.

Note: The following keyboard shortcuts are based on U.S. standard keyboards.

<table>
<thead>
<tr>
<th>Action</th>
<th>Keyboard shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open the Application view</td>
<td>Alt+A</td>
</tr>
<tr>
<td>Open the Model view</td>
<td>Alt+M</td>
</tr>
<tr>
<td>Close the editor</td>
<td>Ctrl+W</td>
</tr>
<tr>
<td>Go to the next editor</td>
<td>Ctrl+F6</td>
</tr>
<tr>
<td>Go to the previous editor</td>
<td>Ctrl+Shift+F6</td>
</tr>
<tr>
<td>Go to the next view</td>
<td>Ctrl+F7</td>
</tr>
<tr>
<td>Go to the previous view</td>
<td>Ctrl+Shift+F7</td>
</tr>
<tr>
<td>Save</td>
<td>Ctrl+S</td>
</tr>
<tr>
<td>Save all</td>
<td>Ctrl+Shift+S</td>
</tr>
<tr>
<td>Show key assistance</td>
<td>Ctrl+Shift+L</td>
</tr>
<tr>
<td>Switch to the editor</td>
<td>Ctrl+Shift+E</td>
</tr>
<tr>
<td>Open a context menu</td>
<td>Shift+F10</td>
</tr>
<tr>
<td>Navigate a menu</td>
<td>Up and Down arrows</td>
</tr>
<tr>
<td>Activate a command on a menu or context menu</td>
<td>Enter</td>
</tr>
<tr>
<td>Move to and select the next enabled menu item or context menu item</td>
<td>Down arrow</td>
</tr>
<tr>
<td>Select the first enabled item in a submenu on a menu or context menu</td>
<td>Right arrow</td>
</tr>
<tr>
<td>Move to and select the previous enabled menu item or context menu item</td>
<td>Up arrow</td>
</tr>
<tr>
<td>Close an opened menu</td>
<td>Esc</td>
</tr>
<tr>
<td>Select or clear a check box</td>
<td>Space bar</td>
</tr>
<tr>
<td>Move to the next item in a dialog box or wizard</td>
<td>Tab</td>
</tr>
</tbody>
</table>
### Table 5: Keyboard shortcuts (continued)

<table>
<thead>
<tr>
<th>Action</th>
<th>Keyboard shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move to the previous item in a dialog box or wizard</td>
<td>Shift+Tab</td>
</tr>
<tr>
<td>Move to the next choice in a drop-down list</td>
<td>Down arrow</td>
</tr>
<tr>
<td>Move to the previous choice in a drop-down list</td>
<td>Up arrow</td>
</tr>
<tr>
<td>Move to and select the next option button</td>
<td>Tab+Space bar</td>
</tr>
<tr>
<td>Move to and select the previous option button</td>
<td>Shift+Tab+Space bar</td>
</tr>
<tr>
<td>Open and display a drop-down list or menu</td>
<td>Alt+Down arrow</td>
</tr>
<tr>
<td>Close an open drop-down list or menu</td>
<td>Alt+Up arrow or Esc</td>
</tr>
<tr>
<td>Close a dialog box or wizard</td>
<td>Esc</td>
</tr>
<tr>
<td>Invoke a selected drop-down item</td>
<td>Enter</td>
</tr>
<tr>
<td>Apply the changes you made and close the dialog box or wizard</td>
<td>Tab to <strong>OK</strong> and press Enter</td>
</tr>
<tr>
<td>Close the dialog box or wizard without applying or saving the changes you made</td>
<td>Esc</td>
</tr>
<tr>
<td>Navigate between the tabs</td>
<td>Left and Right arrows or Tab or Shift+Tab</td>
</tr>
<tr>
<td>Move the current tab to the right</td>
<td>Shift+Page Up</td>
</tr>
<tr>
<td>Move the current tab to the left</td>
<td>Shift+Page Down</td>
</tr>
<tr>
<td>Navigate from icon to icon in the toolbar</td>
<td>Left and right arrows</td>
</tr>
<tr>
<td>Display members of a dimension in the cube viewer</td>
<td>Alt+Down arrow</td>
</tr>
<tr>
<td>Select several rows or columns in the cube viewer</td>
<td>Ctrl+Down arrow</td>
</tr>
<tr>
<td>Replace the existing dimension in the rows with the selected dimension</td>
<td>Ctrl+R</td>
</tr>
<tr>
<td>Replace the existing dimension in the columns with the selected dimension</td>
<td>Ctrl+C</td>
</tr>
<tr>
<td>Replace the existing dimension in the context with the selected dimension</td>
<td>Ctrl+T</td>
</tr>
<tr>
<td>Automatically expand the members in the selected dimension</td>
<td>In the context menu for the selected dimension, Down arrow to the <strong>Expand to level</strong> command and select the level that you want to display</td>
</tr>
<tr>
<td>Expand or collapse a parent in a dimension</td>
<td>Enter</td>
</tr>
<tr>
<td>Refresh the model with the data on the server</td>
<td>F5</td>
</tr>
<tr>
<td>Exit the application</td>
<td>Alt+F4</td>
</tr>
</tbody>
</table>

### IBM and accessibility

See the IBM Accessibility Center (http://www.ibm.com/able) for more information about the commitment that IBM has to accessibility.
Notices

This information was developed for products and services offered worldwide.

This material may be available from IBM in other languages. However, you may be required to own a copy of the product or product version in that language in order to access it.

IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information on the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user's responsibility to evaluate and verify the operation of any non-IBM product, program, or service. This document may describe products, services, or features that are not included in the Program or license entitlement that you have purchased.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not grant you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of information between independently created programs and other programs (including this one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Software Group
Attention: Licensing
3755 Riverside Dr.
Such information may be available, subject to appropriate terms and conditions, including in some cases, payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the results obtained in other operating environments may vary significantly. Some measurements may have been made on development-level systems and there is no guarantee that these measurements will be the same on generally available systems. Furthermore, some measurements may have been estimated through extrapolation. Actual results may vary. Users of this document should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their published announcements or other publicly available sources. IBM has not tested those products and cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or withdrawal without notice, and represent goals and objectives only.

This information is for planning purposes only. The information here is subject to change before the products described become available.

This information contains examples of data and reports used in daily business operations. To illustrate them as completely as possible, the examples include the names of individuals, companies, brands, and products. All of these names are fictitious and any similarity to the names and addresses used by an actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming techniques on various operating platforms. You may copy, modify, and distribute these sample programs in any form without payment to IBM, for the purposes of developing, using, marketing or distributing application programs conforming to the application programming interface for the operating platform for which the sample programs are written. These examples have not been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these programs. The sample programs are provided "AS IS", without warranty of any kind. IBM shall not be liable for any damages arising out of your use of the sample programs.

Each copy or any portion of these sample programs or any derivative work, must include a copyright notice as follows:

© (your company name) (year). Portions of this code are derived from IBM Corp. Sample Programs. © Copyright IBM Corp. _enter the year or years_.

If you are viewing this information softcopy, the photographs and color illustrations may not appear.

This Software Offering does not use cookies or other technologies to collect personally identifiable information.

---

**Product Information**

This document applies to IBM Planning Analytics 2.0.0 and may also apply to subsequent releases.

**Copyright**

Licensed Materials - Property of IBM

© Copyright IBM Corp. 2007, 2017.
US Government Users Restricted Rights – Use, duplication or disclosure restricted by GSA ADP Schedule Contract with IBM Corp.

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of International Business Machines Corp., registered in many jurisdictions worldwide. Other product and service names might be trademarks of IBM or other companies. A current list of IBM trademarks is available on the web in "Copyright and trademark information" at www.ibm.com/legal/copytrade.shtml.

The following terms are trademarks or registered trademarks of other companies:

- Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the United States, other countries, or both.
- Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States, and/or other countries.
- Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.
- UNIX is a registered trademark of The Open Group in the United States and other countries.
- Java and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle and/or its affiliates.

Microsoft product screen shot(s) used with permission from Microsoft.
Index

A
accessibility
  keyboard shortcuts 45
account information 6
ASCIIOutput function 43
assigning an IP whitelist 13

C
client components 4
cloud system 2
Cognos Command Center 21, 27
controlling access to services and shared folders 13

D
data migration 37
development environment 1
documentation 15, 27

F
file management 34
file transfer 35
finding information v
FTPS 35

H
hosted applications 4

I
IBM Planning Analytics
  account information 6
  applications and components 4
  environments 1
  getting started 1
  language configuration 14
  remote desktop connection 8, 11
  shared folder 5
  system overview 2
with Planning Analytics for Microsoft Excel 17
with TM1 Applications 19
with TM1 Architect 20
with TM1 Operations Console 19
with TM1 Performance Modeler 21
with TM1 Perspectives 20
with TM1 Prism 17
with TM1 Web 18
with Windows Server 2012 12
IBM Planning Analytics Digital Pack 4
IBM Planning Analytics Welcome Kit 6
introduction v

K
keyboard shortcuts
  accessibility 45

L
language configuration 14
local applications 4

N
non-production environment 1

O
overview 2

P
passwords 6
Planning Analytics for Microsoft Excel 17
production environment 1

R
relative path 43
remote desktop connection 8, 11
running components 17

S
shared folder
  moving files between local and cloud 35

T
technical considerations 43
TextOutput function 43
TM1 Applications 19
TM1 Architect 20
TM1 components 4
TM1 on Cloud
  with Cognos Command Center 21, 27
TM1 Operations Console 19
TM1 Performance Modeler 21
TM1 Perspectives 20
TM1 Server
  managing 29
  stopping and starting 29
TM1 user accounts 34
TM1 Web 17, 18

U
user names 6